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Disclaimer 
Thunderhead Engineering makes no warranty, expressed or implied, to users of 
Pathfinder, and accepts no responsibility for its use. Users of Pathfinder assume sole 
responsibility under Federal law for determining the appropriateness of its use in any 
particular application; for any conclusions drawn from the results of its use; and for any 
actions taken or not taken as a result of analyses performed using these tools. 

Users are warned that Pathfinder is intended for use only by those competent in the 
field of egress modeling. Pathfinder is intended only to supplement the informed 
judgment of the qualified user. The software package is a computer model that may or 
may not have predictive capability when applied to a specific set of factual 
circumstances. Lack of accurate predictions by the model could lead to erroneous 
conclusions. All results should be evaluated by an informed user. 
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1. Introduction 
Pathfinder is an agent based egress and human movement simulator.  It provides a graphical user 

interface for simulation design and execution as well as 2D and 3D visualization tools for results analysis.  

Graphical User Interface 
Pathfinder includes a graphical user interface that is used primarily to create and run simulation models.  

A screenshot of this user interface is shown in Figure 1-1.  This screenshot displays a model of the 

Theater de Vest in Alkmaar, Netherlands. The model was created by Van Hooft Adviesburo. For clarity, 

the image shows only one of the dxf files used to create the geometry. The model includes 2177 

occupants. 

 

Figure 1-1: An example of the graphical user interface. Model of the Theater de Vest created by Van 

Hooft Adviesburo. 

Pathfinder also includes a second program designed specifically for high-performance visualization of 3D 

time history.  The 3D Results program is shown in Figure 1-2.  In this image, occupants are gathering at a 

refuge area before proceeding to elevators. Transparency has been used to help view occupants on the 

refuge floor. 
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Figure 1-2: An example of the 3D Results view, showing occupants gathering at a refuge area before 

proceeding to elevators. Transparency has been used to help view the occupants. 

In addition to 3D visualization, Pathfinder also provides output in the form of 2D time history plots of 

CSV (comma separated values) out files and a text summary of room clearing times and doorway flow 

rates.  An example time history plot can be seen in Figure 1-3.  This plot shows the number of occupants 

in the refuge area and the total number of occupants in the building. 

 

Figure 1-3: An example time history graph 
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Model Representation 
The movement environment is a 3D triangulated mesh (Figure 1-4) designed to match the real 

dimensions of a building model.  This movement mesh can be entered manually or automatically based 

on imported data (e.g. FDS geometry). 

Walls and other impassable areas are represented as gaps in the navigation mesh.  These objects are not 

actually passed along to the simulator, but are represented implicitly because occupants cannot move in 

places where no navigation mesh has been created. 

Doors are represented as special navigation mesh edges.  In all simulations, doors provide a mechanism 

for joining rooms and tracking occupant flow.  Depending on the specific selection of simulation options, 

doors may also be used to explicitly control occupant flow.  

Stairways are also represented as special navigation mesh edges and triangles.  Occupant movement 

speed is reduced to a factor of their level travel speed based on the incline of the stairway.  Each 

stairway implicitly defines two doors.  These doors function just like any other door in the simulator but 

are controlled via the stairway editor in the user interface to ensure that no geometric errors result from 

a mismatch between stairways and the connecting doors. 

Elevators are called to a floor when occupants arrive at the elevator door. The elevator model includes 

capacity, pick-up and discharge floors, and the ability to group elevators in banks.  

 

Figure 1-4: The triangulated navigation mesh used to represent one floor in the model. 

Each occupant is defined by position, a profile that specifies size, speed, etc., and a behavior that defines 

goals for the occupant. The behavior allows scripting so that, for example, an occupant may wait at a 

location for a specified time and then proceed to an elevator. The occupant is represented as an upright 
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cylinder on the movement mesh and movement uses an agent-based technique called inverse steering.  

Each occupant calculates movements independently. 

Simulation Modes 
Pathfinder supports two movement simulation modes.  In "Steering" mode, doors do not act to limit the 

flow of occupants; instead, occupants use the steering system to maintain a reasonable separation 

distance.  In SFPE mode, occupants make no attempt to avoid one another and are allowed to 

interpenetrate, but doors impose a flow limit and velocity is controlled by density. 

You can freely switch between the two modes within the Pathfinder user interface and compare 

answers.  More information about both modes is provided in the Technical Reference manual. 

Limitations and Known Issues 
Pathfinder does not presently integrate results from a fire model or provide support for complex 

behaviors (e.g. family grouping).  

Dynamic geometry is only partially supported (e.g. elevators, virtual escalators, and door 

opening/closing are supported, but trains and other moving surfaces are not). 

Elevators are supported in evacuation-only circumstances.  They do not model a general-purpose 

elevator system. 

Simulator Name 
The name Pathfinder has been used previously to describe a 2D egress simulator created and used 

internally by Rolf Jensen and Associates.  While the original Pathfinder inspired some of the features of 

the new simulator, the simulator described in this manual does not use any of the code from the original 

Pathfinder software. 

System Requirements 
System requirements depend on the type of model being analyzed. To illustrate this, two different 

models were evaluated using a laptop running 64-bit Windows 8 Pro with an Intel Core i7 2.60 GHz 

processor, 8 GB of RAM, and NVIDIA NVS 5200M graphics card. The first model had a single room with 

50,000 occupants and did not include any imported geometry. The second model imported a relatively 

complex Revit model to create the Pathfinder model and had 3,000 people, Figure 1-5. 

Table 1-1 shows a comparison of the two models. The key parameters are the number of people in the 

model and the model complexity, measured by the number of navigation mesh triangles used in the 

Pathfinder solution and the number of imported Revit primitives (triangles). The simple model had only 

4 triangles, with the consequence that the movement calculation of the path for each person is simple 

and that display performance is related to the drawing of people. The Revit model had 21,480 triangles 

for the navigation mesh but over 1,300,000 triangles for the Revit geometry. 

The model with 50,000 people solved in about 18 minutes, while the Revit model with 3,000 people 

took about 5 minutes. The graphical display performance for the model with 50,000 people was 
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responsive at 15 frames/sec, while the Revit model with the imported geometry displayed was slow at 5 

frames/sec. When only the Pathfinder navigation mesh was display, the Revit model was responsive. 

  
a. Model with 50,000 people b. Revit import model with 3,000 people 

Figure 1-5: Models used for system requirements comparison 

Table 1-1: Comparison of performance for the two models 

Parameter 
Model 

People Revit Import 

Number of occupants 50,000 3,000 

Number navigation triangles 4 21,480 

Number Revit face primitives 0 1,300,000 

CPU solution time (s) 1090 297 

Navigation mesh display rate (fps) ~15 ~70 

Imported geom display rate (fps) n/a ~5 

 

The minimum requirements to run Pathfinder include: 

 32 or 64-bit Windows XP (Windows 7 or higher strongly recommended) 

 A processor the performance of an Intel i5 

 4 GB of RAM 

 Graphics support for OpenGL 1.2 

For a balanced performance we recommend: 

 64-bit Windows 7 or higher 

 Intel i7-3770 (3.4 GHz, 4 Cores) processor 

 8 GB of RAM 

 Graphics support for OpenGL 3.2 with an installed graphics card for large Revit models. 
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Revit models place a premium on graphics capability. We have found that mid-cost gaming graphics 

cards (GeForce GTX 570 / Radeon HD 7870 or equivalent) allow us to display relative large Revit models 

with good performance. Benchmarking sites that we find useful to compare CPU and graphics card 

performance can be found at: http://www.cpubenchmark.net/ and 

http://www.videocardbenchmark.net/. 

Contact Us 
Thunderhead Engineering 

403 Poyntz Avenue, Suite B 

Manhattan, KS 66502-6081 

USA 

Sales Information: sales@thunderheadeng.com 

Product Support: support@thunderheadeng.com 

Phone and Fax: +1.785.770.8511 

http://www.cpubenchmark.net/
http://www.videocardbenchmark.net/
mailto:sales@thunderheadeng.com
mailto:support@thunderheadeng.com
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2. Pathfinder Basics 
Pathfinder provides three main views for working on evacuation models:  the 2D View, 3D View, and 

Navigation View.  These views represent your current model.  If an object is added, removed, or selected 

in one view, the other views will simultaneously reflect the change.  Each view is briefly described 

below. 

 Navigation View:  This view lists all objects in the model in a hierarchical format.  It can be used 

to quickly locate and modify objects by name. 

 3D View:  This view shows a 3D representation of the current model.  The model can be 

explored and modified using various tools. 

 2D View:  This view is very similar to the 3D View, but it provides an additional snapping grid 

and an orthographic view of the model. 

Navigation View 
The Navigation View helps you quickly find objects and data that are not 

always easily accessible from the 3D and 2D views. 

The Navigation View is arranged in six groups: 

1. The Imported geometry group stores items that were imported from 

an image or an FDS, PyroSim, or DXF model.  These objects do not 

affect the simulation but are carried through to help with results 

analysis.  They can also be used to automatically extract rooms. 

2. The Profiles group  contains the occupant profiles that have been 

created using the Edit Profiles dialog. 

3. The Behaviors group contains user-defined scripts that tell 

occupants how to behave. 

4. The Occupants group  contains every occupant in the model.  If 

occupants are added to the model using a tool that adds more than 

one occupant at a time, they will be collected in a sub-group. 

5. The Elevators group contains evacuation elevators in the model. 

6. The Floors group defines the floors in the model, and each floor contains all geometry necessary 

to create a movement mesh, including room, stairway, ramp, door, and exit definitions. 

The buttons directly above the Navigation View perform the following actions: 

 Auto Expand Selection when an object (or occupant) in the 3D or 2D view is selected, this 

action will expand the groups of the Navigation View as needed to show the selected object. 

 Collapse All collapses all expanded groups in the Navigation View. 

 Expand All expands all groups in the Navigation View (including sub-groups) 
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The Floor box above the view can be used to manage floors.  Any time a room, stair, ramp, or door is 

created it is added to a floor group matching the current selection in the Floor box.  Changing the 

selection in the Floor box will cause the newly selected floor to be shown and all other floors to be 

hidden.  Also, the Z property for all drawing tools will automatically default to the height of the floor 

currently selected in the Floor box.  The visibility of any object or group of objects can always be 

manually set using the right-click context menu.  This technique is useful if you want to show two floors 

at the same time (e.g. when creating a stairway). 

3D and 2D Views 
The 3D and 2D views as shown in Figure 2-1 are the main views in which drawing is performed in 

Pathfinder.  Both views contain tools to draw egress geometry and navigate in a model.  The main 

difference between the two views is that the 3D view allows the model to be viewed from any direction, 

whereas the 2D view only allows viewing from one, orthographic direction.  In addition, the 3D view 

contains no snap grid, whereas the 2D view does.  The 3D view is entered by selecting the perspective 

camera, , and the 2D view is entered by selecting one of the orthographic cameras, , , or . 

At the top of the view is several buttons that show different camera modes, display options, and 

navigation modes.  The panel under this is known as the property panel and is a selection context-

sensitive panel.  If a drawing tool is selected, it will show properties that can used to help draw.  If no 

drawing tool is selected, and an object or several objects are selected, this panel will show the 

properties relevant to the selection.  The panel of buttons on the left shows move/copy and drawing 

tools.  The small panel at the bottom displays messages relevant to the current tool. 

 

Figure 2-1: 3D and 2D views 

Navigating the 3D view 

Several tools are provided for navigating through the model in the 3D view, including orbit, roam, pan, 

and zoom tools. 
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The main navigation tool for the 3D view is the Orbit tool, .  By left-clicking and dragging, the model is 

rotated about its center point. The scroll-wheel can be used to zoom in and out on a specific point.  

Holding SHIFT on the keyboard and then clicking and dragging will pan the camera, and holding ALT 

while dragging will zoom in and out.   

Another navigation tool in the 3D view is the Roam tool, .  This tool allows the camera to move in and 

out of the model at will. Without holding any keyboard keys, dragging the mouse will cause the camera 

to rotate about the camera’s location.  So dragging the mouse up will make the camera look up, and 

dragging it left and right makes it look left and right. Holding CTRL while dragging will make the camera 

move forward and backward in the XY plane, and holding ALT while dragging will make the camera move 

up and down along the Z axis.  This tool has a higher learning curve but is the most flexible viewing tool 

because it allows the camera to be placed anywhere in the model. 

The other navigation tools include a pan/drag tool, which moves the camera left and right and up and 

down, a zoom tool, which zooms in and out of the model while click-dragging, and a zoom box tool, 

which allows a box to be drawn that specifies the zoom extents. 

Pathfinder can also be navigated while using the Selection/manipulation tool, .  To Orbit the camera 

while in perspective view, use a right-click and drag combination.  Similarly, use a middle-click and drag 

to Pan in perspective view.   

Navigating the 2D view 

Navigation in the 2D view is simpler than in the 3D view.  The selection tool not only allows objects to be 

selected if single-clicked, but it allows the view to be panned by middle or right-clicking and dragging, 

and the view to be zoomed by using the scroll wheel.  The drag and zoom tools are also separated into 

separate tools for convenience. 

Resetting the view 

At any time, the camera can be reset by pressing CTRL+R on the keyboard, or selecting Reset All tool, .  

This will cause the entire model to be visible in the current view.  For all navigation tools but the Roam 

tool, reset will make the camera look down the negative Z axis at the model.  For the roam tool, 

however, reset will make the camera look along the positive Y axis at the model. 

The camera can also be reset to the current selection at any time by pressing CTRL+E.  This will cause the 

camera to zoom in on the selected objects and the orbit tool to rotate about the center of their 

bounding sphere. 

Filling the view 

Very similar to resetting the camera, the view can be fit by pressing F on the keyboard or selecting the 

Fit View tool, .  The difference between the Fill View and Reset All tools is that filling the screen does 

not change the view angle of the camera.  Instead the camera will recenter/rezoom to fit the screen. 
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Drawing in the 3D and 2D views 

Drawing can be performed in both the 3D view and the top 2D view.  The 3D view allows the user to see 

the model from any angle, but most tools restrict drawing in the XY plane.  The top view completely 

restricts drawing to the XY plane, but it also displays an optional snap grid. The snap grid size can be set 

under Edit snap grid spacing in the View menu, and it can be turned off by deselecting Show Snap Grid 

in the View menu. 

Drawing is performed in one of the two following modes: 

 Normal Mode:   Single-click a drawing tool button on the left side of the view.  Draw the object 

using the instructions in the appropriate section of the manual.  When the object has been 

completed, the drawn object(s) will be selected and the view will revert to the previous 

navigation tool.   

 Sticky Mode:  Double-click a drawing tool’s button on the left panel before beginning to draw.  

When the object is completed, the same drawing tool will remain selected and more objects can 

be drawn with the tool.  To escape this mode, press ESC on the keyboard, and the previous 

navigation tool will be selected.  A green dot on the tool’s icon indicates that the tool is 

currently in sticky mode.  Single-clicking the tool’s icon again will turn off sticky mode but keep 

the tool selected. 

At any time while drawing, the user can press escape, which causes the current object to be cancelled 

and the previous navigation tool to be selected.   

For each tool there are often two ways to create its object.  One way is to draw the object graphically 

using the mouse and keyboard.  The other is to interactively create the object by typing information 

such as coordinates, widths, etc. in the tool’s property panel.  The property panel will update the 

graphical preview immediately to reflect changes in the input.  This allows fine-grained control in 

creating the object.  The individual drawing tools are discussed in Creating Movement Space. 

View Options 
Pathfinder provides a variety of view options for displaying both navigation geometry and imported 

geometry that can also aid with drawing.  This includes options for rendering geometry, displaying 

agents, coloring rooms, and setting the transparency of rooms. 

Render Options 

In the toolbar above the properties window in the 2D and 3D views, there are a number of buttons as 

shown in Figure 2-2 that control how geometry is rendered. 

 

Figure 2-2: Render options 
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From left to right, the buttons are Wireframe Rendering, Solid Rendering, Show Materials, Show 

Object Outlines, Smooth Lighting, Show Navigation Geometry, Show Imported Geometry, and Show 

Occupants. 

 Wireframe Rendering:  displays imported 3D geometry as wireframe only.  This option is 

mutually exclusive with the solid rendering option.  It is useful for drawing doors in the 2D view 

when 3D geometry has been imported. 

 Solid Rendering: displays imported 3D geometry filled in.  This is selected by default. 

 Show Materials: shows materials applied to the faces of imported 3D geometry. This is selected 

by default. 

 Show Object Outlines: shows the outlines of 3D imported geometry.  This is similar to showing 

the wireframe and solid versions at the same time. 

 Smooth Lighting: uses a more realistic shading model to show all geometry.  This may be a little 

slower to render on older graphics cards. 

 Show Navigation Geometry: This toggles the visibility of all the navigation geometry.  It does 

not affect anything else (including imported geometry and occupants). 

 Show Imported Geometry: This toggles the visibility of all imported 3D geometry. 

 Show Occupants: This toggles the visibility of occupants. 

Occupant Display 

Occupants can be displayed using a number of options.  They can be viewed as simple shapes, including 

disks and cylinders.  They can also be displayed as the artist’s mannequin or as their respective human 

avatars specified in their profiles.  These options are available under View menu and Agents submenu. 

Coloring Rooms 

Rooms can be colored in a variety of ways.  All coloring options are available under the View menu and 

Color Rooms submenu.  The default option is to display each room with a unique color.  They can also 

be colored by occupant density, with red indicating high density and blue low density. The last option is 

to use a mixed mode.  In this mode, the rooms are only colored by concentration if they contain agents; 

otherwise, they are colored with their unique colors.  

Room Opacity 

Sometimes it is useful to be able to see through rooms and stairways, such as when drawing on top of 

an imported background image.  To change the opacity of a set of components, select them and in the 

property panel, change the opacity. Opacity settings will carry through to 3D results visualization. 

Model Organization with Groups 
The main method of organization in Pathfinder is to use groups.  In every model there are already some 

implicit groups that cannot be modified, including Imported Geometry, Profiles, Behaviors, Occupants, 

Elevators, and Floors as shown in Figure 2-3.  Sub-groups can be created to further organize the model 

as discussed in the following sections. 
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Figure 2-3: Predefined groups 

Creating sub-groups 

Sub-groups can be created under Imported Geometry, Occupants, Elevators, and Floors (floors are 

discussed in the section, Floors).  Groups can also be created in other sub-groups.  To create a new 

group, right click the desired parent group in the navigation view and select New Group… or select New 

Group… from the Model menu.  A dialog will display allowing the user to select the parent group (which 

will automatically be selected if performed from the right-click menu) and a name for the new group.  

Click “OK” to create the new group. 

Changing groups 

An object can be moved from one group to another at any time.  To change an object’s group, drag the 

object to the desired group in the Navigation View or right click the object and select Change Group….  

This will show a dialog that will allow the user to choose the new group.  The options shown for the new 

group will only be valid groups for which the group can be changed.  Select “OK” to change the group. 
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3. Creating Movement Space 
Pathfinder is built on the idea of creating floor space on which occupants can walk.  Every navigation 

component drawn in Pathfinder is some piece of flooring that can be travelled on, which can range from 

floors, to doorways, to stairs.  Obstructions exist as holes in the floor. 

The main egress components include rooms, which are empty floor spaces bounded by walls, doors, 

which connect rooms on the same level, stairs/ramps, which connect rooms on different levels, and 

elevators, which connect multiple levels.  Rooms can have any polygonal shape, and can never overlap 

on the same level.  Doors can be either thick if they are occupying a doorway (the area between two 

rooms) or thin if they are simply connecting two touching rooms.  Stairs/ramps are always rectangular 

and implicitly contain a thin door on each end to connect the adjacent rooms.  Elevators can be any 

shape and can travel in any direction. 

To organize egress components, Pathfinder provides the concept of floors, which group together 

components at different Z locations.  

Floors 
Floors are the primary method of organization in Pathfinder.  At their most basic level, they are simply 

groups in which rooms, doors, stairs, ramps, and exits can be placed, but they also control the drawing 

plane for most tools and filtering of imported geometry.   

In every Pathfinder model, at least one floor must exist, and at any given time, there is one active floor.  

Whenever any navigation object is drawn, it will either be placed in the active floor or a subgroup of the 

active floor. 

By default when a new model is started, there is one floor at Z=0, and additional floors are either 

created automatically depending on where the geometry is drawn or manually created.  In addition, 

new navigation components are automatically sorted into the appropriate floor when drawn. 

Automatically creating floors 

When nothing is selected in the model, the Floor Creation panel is shown, as in Figure 3-1.  This panel 

controls the automatic creation of floors and automatic sorting of new objects into floors.   

 

Figure 3-1: Floor Creation panel 

 Auto sort egress components – If this is checked, navigation components are automatically 

sorted into the appropriate floor when created or modified; if this is unchecked, new navigation 
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components are placed in the group specified under New Egress Components and remain in this 

group until manually moved. 

 Automatically create floors – If this is checked, floors are automatically created as navigation 

components are created and modified. 

 Floor height – This specifies the height at which new floors are automatically created.  If a 

navigation component is created or moved to a location that is at least this distance from the 

previous floor, a new floor will be created at a multiple of this distance from the previous floor. 

 Group – If Auto sort egress components is unchecked, this drop-down specifies the group/floor 

for new navigation components. 

The following scenario demonstrates how objects are organized when auto-sort and auto-floor-creation 

are enabled (organization of the model is shown in Figure 3-2): 

1) A new model is created.  The floor height is left at the default of 3 m. 

2) “Room00” is drawn at Z=0 m, and is auto-placed in “Floor 0.0 m.” 

3) “Room01” is drawn at Z=1.5 m, and is auto-placed in “Floor 0.0 m.” 

4) “Stair01” is drawn connecting “Room00” to “Room01” and is auto-placed in “Floor 0.0 m.” 

5) “Room02” is drawn at Z=-1.5 m.  A new floor, “Floor -3.0 m” is auto-created, and “Room02” is 

auto-placed in it. 

6) “Stair02” is drawn connecting “Room02” and “Room00” and is auto-placed in “Floor -3.0 m.” 

7) “Room03” is drawn at Z=7.5 m.  A new floor, “Floor 6.0 m” is auto-created, and “Room03” is 

auto-placed in it. 

 

Figure 3-2: Auto floor creation and sorting 

In this example, only rooms and stairs were created.  The floors were automatically created and the 

rooms and stairs were automatically sorted into the appropriate ones. 

Using Auto-sort with an Existing Model 

Automatic floors can be created and components sorted into the floors by performing the following: 

1) Open the model. 

2) Clear the selection so that the Floor Creation panel is visible (Figure 3-1).   

3) Ensure that the desired creation/sorting options are enabled and that the correct floor height 

for the model is set. 
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4) Select all the components that should be auto-sorted (if everything should be sorted, select  the 

Floors top node). 

5) Right-click the selection, and from the shortcut menu, click Sort into Floors. 

6) The appropriate floors will be created and all selected items will be sorted into the appropriate 

floors. 

NOTE: This will not delete any existing floors.  If there are undesired existing floors, first move the 

navigation components out of them to another floor that will be kept, delete the undesired floors, and 

then perform Sort into Floors. 

Manually creating floors 

Floors can also be created manually at any time.  To do so, click on the floor drop-down box above the 

Navigation View, and select <Add New…> as shown in Figure 3-3.  A dialog will open asking for the floor 

location. Enter the Z plane location or click on a snap point in the 3D or 2D view and click okay.  This Z 

plane will be used to update the drawing tools’ working Z location when this floor is made active.  By 

default, the name of the floor is “Floor x” where x is the working plane of the floor.  If Set as active floor 

is selected in the new floor dialog, the floor is set to be the active floor in the model after being created.  

If Resort existing egress components into new floor is selected, then all existing components that 

belong in the new floor will be moved to it. 

       

Figure 3-3: Adding a new floor 

Changing the active floor 

To change the active floor, click the floor drop-down box as shown in Figure 3-3, and select the desired 

floor.  This will make that floor active and all other floors non-active. 

Whenever the active floor is changed, the following additional changes take place in the model: 

 The floor, all objects in the floor group, and all occupants on the floor are set visible. 

 All other floors, sub-objects of other floors, and occupants on those floors are set hidden. 

 The working plane of the room and wall subtraction tools is set to the working plane of the 

floor. 

 A clipping filter is applied to imported geometry so that only geometry within the Z clipping 

planes of the active floor is visible. 
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Showing all floors 

To show all floors click the floor drop-down box as shown in Figure 3-3, and click <Show All>.  This will 

additionally show all occupants on the floors and all sub-objects of the floors groups, and it will set the 

import filter to the union of all the floors’ filters. 

Floor Properties 

To edit a floor’s properties, first select the desired floor.  The property panel as shown in Figure 3-4 will 

appear, showing the floor’s name, its working Z location, and the Z clipping planes for imported 3D 

geometry.  It also shows some statistics of the floor including the total area of the floor (Area), number 

of people on the floor (Pers) and density of people.  

 

Figure 3-4: Floor property panel 

The Working Z property controls the plane on which new rooms and wall obstructions are drawn. 

The Z min and max filters control the clipping planes of imported 3D geometry when the floor is visible.  

Anything below Z min and above Z max is clipped.  The Z Min Filter property can either be a Z plane 

location or can have the special value, CURR_FLOOR.  If it is CURR_FLOOR, then the clipping plane is set 

to the working Z location if there are any floors below this floor or –∞ if there are no floors below.  The 

Z Max Filter can be a Z plane location or can have the special value, NEXT_FLOOR.  If it is NEXT_FLOOR, 

then the Z plane is set to the working Z plane of the next higher floor if one exists, or +∞ if there are no 

higher floors.    

Rooms 
Rooms are open space on which occupants can freely travel.  Each room is bounded on all sides by walls.  

Rooms can be drawn so that they touch each other, but an occupant can only travel between them if 

they are connected by a door. Only one room can occupy a given space at any time, so if one room is 

drawn overlapping another, the overlapping area will be subtracted from the old room and given to the 

new.  Rooms can also be merged into one, separated into constituent parts, and have internal, thin 

boundaries drawn in them.  These features are discussed in the following sections. 

Adding new rooms 

Pathfinder provides two tools for adding new room geometry:   

 Polygonal Room Tool: The Polygonal Room tool ( ) allows for the creation of complex shapes 

with any number of vertices. Left-click anywhere in the model to set the first point, and 

continue left clicking to add more points to the polygon. When at least three points are defined, 

right-clicking will close the polygon and complete the shape. Alternatively, x-y coordinates can 

be entered from the keyboard with the Add Point and Close Polygon buttons from the property 

panel.  
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Figure 3-5: Drawing a room with the polygon tool 

 Rectangular Room Tool:  The Rectangular Room tool ( ) creates simple rectangular geometry 

by left-clicking two points in the model. The rectangular area can also be created by entering 

coordinates for two points in the property panel and clicking the Create button. 

 

Figure 3-6: Drawing a room with the rectangle tool 

In addition to creating new areas, both of these tools can be used on existing geometry to create 

negative areas. Creating new geometry over existing areas removes any interfering portion from those 
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areas. The newly created geometry can then be deleted, leaving the negative space behind.  This is 

discussed further in the section, Arbitrarily-shaped obstructions (desks, tables, etc.). 

Drawing Plane 

Each room tool draws on a particular Z plane that is specified in the property panel for the tool as shown 

in Figure 3-7.   

 

Figure 3-7: Drawing plane property 

The Z plane can be specified either manually by typing the location into the Z Plane field or by picking 

the location from the 2D or 3D View as follows: 

1. Select one of the room drawing tools. 

2. In the tool property panel, click Pick Z from Scene.  This will clear the tool property panel while 

waiting for the user to click a location. 

3. Click a point in either the 3D View or a 2D View. The tool property panel will return for the 

selected drawing tool, and the Z Plane field will be filled with the Z coordinate of the clicked 

location. 

Thin walls 

Thin, internal walls or boundaries can be added to rooms with the Thin Wall tool ( ).  To use this tool, 

click two points in the model as shown in Figure 3-8.  Pathfinder will attempt to connect these two 

points with an internal boundary edge. NOTE: In some circumstances, Pathfinder may have trouble 

connecting the two points. If this occurs, try limiting the two points to one room or to the number of 

room boundaries crossed. 

   

Figure 3-8: Adding a thin wall to a room 
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Splitting rooms 

Rooms can be split into two or more pieces using the Thin Wall tool. To do this, specify the two points 

such that they are on the outermost boundary of the room to be divided.  The original geometry will be 

divided into two or more new rooms with that line as the boundary between them as shown in Figure 

3-9. 

 

Figure 3-9: Dividing a room 

Note that drawing a thin wall between two boundaries of the room will not always split the rooms into 

multiple pieces as shown in Figure 3-10.  In this case, the tool will simply add a thin wall. 

 

Figure 3-10: Special case for drawing a thin wall 

Separating and merging rooms 

In addition to dividing rooms, Pathfinder has two additional means to aid in creating more complex 

room geometry. 

 Merge:  The Merge command is used to join two or more rooms that share boundaries into one 

room. To use it, select the neighboring rooms and select Merge from either the Model menu or 

the right-click menu.  NOTE: Rooms can be merged even if they do not lie in the same plane as 
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long as they share a common edge.  They can also be merged with stairs and ramps, but the 

stairs and ramps will be converted into rooms and will lose their stair/ramp properties. 

 

Figure 3-11: Merging rooms 

 Separate: The Separate command breaks a room into its constituent parts along any negative 

space that divides it. To use it, select the room to be separated and select Separate from either 

the Model menu or the right-click menu. 

 

Figure 3-12: Separating a room 

Room properties 

To view and edit room properties, select a room.  Its properties will be displayed in the property panel 

as shown in Figure 3-13. 

 

Figure 3-13: Room properties panel 
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 Name:  An identifying name for room. 

 Visible:  Whether the room is currently visible. Uncheck to hide the room. 

 Color: The color of the room. If unchecked, a default room color is used. 

 Opacity: The opacity of the room. Making this value less than 100% will cause objects behind 

the room to become visible. 

 X, Y, and Z Bounds: The geometric bounds of the room. 

 Area: The geometric area of the room. 

 Pers: The number of occupants currently placed in the room. 

 Density: The number of occupants/area 

 Speed Modifier: A time-variable factor that affects the speed of each occupant who travels in 

the room. When occupants travel in the room, their maximum speed is multiplied by this factor. 

This could be used, for instance, to represent the effect of smoke on occupant speeds. 

By default, the modifier is 1.0 throughout the simulation. To change this, click the link. The Edit 

Speed Modifier dialog appears as shown in Figure 3-14.  In this figure, for instance, the room 

initially leaves occupant speeds unmodified, but over the first 40 seconds ramps occupant 

speeds down to 25% of their maximum values. 

 

Figure 3-14: Edit Speed Modifier dialog 

Preventing room-crossing 

In some cases, such as modeling seating rows or shops in a mall, it may be desirable to only allow 

occupants to exit the room and not cross through it.  This can be accomplished by making all the doors 

connected to the room one-way (see Doors) and ensuring that their directions point out of the room.  

Pathfinder provides a tool to make this easy.  Instead of individually setting the one-way status of all the 

connecting doors, perform the following: 

1. Select the room(s) that should not be crossable. 

2. Right-click one of the rooms, and from the menu select Make Doors Oneway…. 

3. A dialog will appear as in Figure 3-15. From this dialog, choose whether occupants can only 

Enter or Exit the room.  If any of the room’s doors were already marked as one-way, another 
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option will be provided to overwrite the one-way status of those doors. Press OK in this dialog 

to make the doors one-way. 

Pathfinder will automatically calculate the correct directions for the doors to make the rooms exit-only 

or enter-only. 

 

Figure 3-15: Make Doors Oneway dialog 

NOTE: If any doors were shared between rooms in the selection, those doors will not be affected, as 

their direction would be ambiguous. 

Obstructions/Holes 
In Pathfinder, obstructions are modeled as holes in the navigation geometry.  Holes can be created with 

an arbitrary polygonal shape or as thick walls. 

Arbitrarily-shaped obstructions (desks, tables, etc.) 

To model an obstruction (e.g. an office desk or other standing obstacle) within a room, the subtractive 

property of rooms is used.  This means that the room containing the obstruction must already exist.  To 

create the obstruction, select the Add a Polygonal Room tool or the Add a Rectangular Room tool and 

draw the shape and location of the obstructed area.  This will subtract the area from the old room and 

create a new room.  Next, delete the new room.  A hole is left in the old room in the shape of the 

obstruction.  This process is shown in Figure 3-16. 
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(a) (b) 

  
(c) (d) 

Figure 3-16: Creating an obstruction 

Thick walls 

The wall tool ( ) is used to make rectangular obstructions in existing geometry. To use this tool, enter 

the desired wall width in the property panel and click or click-drag the two points the wall is to pass 

through. Holding the shift key will switch between alignment left and right of the defining line.  This tool 

is shown in Figure 3-17. 

 

Figure 3-17: Subtracting walls 
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NOTE: The thick wall tool is not as robust as the thin wall tool.  It operates by subtracting area from any 

room that lies in its specified Z plane, whereas the thin wall tool will follow the slope of multiple rooms 

to connect two points. 

Doors 
In Pathfinder, occupants cannot pass between two rooms unless they are joined by a door.  Also, the 

simulator requires that each occupant must have a path to at least one exit door.  Doors provide useful 

flow measurements in simulation results.  Also, in the SFPE mode doors act as the primary flow control 

mechanism.  You can add doors using the Add a New Door tool. 

When adding doors, different parameters provide hints to Pathfinder for finding a valid door as shown in 

Figure 3-18.  The Max Width parameter is used as a target width for the door.  If the full width isn't 

available, Pathfinder will display a shorter door as you hover with the mouse.  The Max Depth 

parameter represents the depth of the door cavity and is used to determine how far apart two rooms 

can be and still be joined by a door.  Doors can be added between rooms that are separated by up to 

this distance. 

 

Figure 3-18: Door tool property panel 

Thin doors 

Thin doors can be used to connect two rooms that touch one another as shown in Figure 3-19.  A door is 

needed in this example to allow occupants to travel from one room to the other.  To create a door in 

this manner, first select the door tool  and then use one of the following three methods: 

 Manual Entry: Enter the coordinates of the door in the property panel.  If the coordinates 

specify a valid door location, the Create Door button will enable.  Click this button, and a door 

no larger than Max Width will be created.  For thin doors, Max Depth will be ignored. 

 Single Click: Move the cursor over the desired door location in the 3D or 2D view.  A preview 

door will be displayed if the cursor is on a valid edge.  The door displayed will lie either to the 

left or right of the hover point relative to the boundary edge, depending on whether Max Width 

is positive or negative.  Single click to place the door.  The previewed door will then be added to 

the model. 

 Click-drag: Move the cursor over the location of one end point of the door, and click drag along 

the same edge.  While dragging, a preview door will be displayed from the first to the second 

point.  When the mouse is released, a door is created along the edge between the two specified 

points.  Creating a door in this manner ignores all the properties in the tool panel. 

The created door will appear as a thin, orange line in the 3D and 2D views as shown in Figure 3-19. 
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Figure 3-19: Adding a thin door to connect two touching rooms 

Thick doors 

Thick doors are often useful in realistic models, especially when CAD geometry has been imported.  In 

real scenarios, rooms will not touch each other by infinitely thin walls as shown in Figure 3-20.  To create 

a thick door to connect these rooms, first select the door tool  and then use one of the following 

three methods: 

 Manual Entry:  Make sure Max Depth is greater than or equal to the distance between the 

edges the door will lie between.  Enter a point on one of the edges in the property panel.  If the 

coordinates specify a valid door location, the Create Door button will enable.  Click this button, 

and a door no larger than Max Width will be created. 

  Single Click:  Make sure Max Depth is greater than or equal to the distance between the edges 

the door will lie between.  Then move the cursor over the desired door location in the 3D or 2D 

view.  A preview door will be displayed extending between the rooms if the cursor is on a valid 

edge.  The door displayed will lie either to the left or right of the hover point relative to the 

boundary edge, depending on whether Max Width is positive or negative.  Single click to place 

the door. 

 Click-drag:  Move the cursor over the edge of one of the rooms, and click drag along the 

corresponding edge on the second room.  While dragging, a preview door will be displayed 

connecting the two edges.  When the mouse is released, a door is created between the edges of 

the two rooms, where the diagonal of the rectangular door connects the two specified points.  

Creating a door in this manner ignores all the properties in the tool panel. 

The created door will appear as an orange rectangle in the 3D and 2D views as shown in Figure 3-20.   

When simulating, thick doors have a special representation: the area of the door will be partitioned in 

two, and each half is attached to its touching room.  A thin door is placed in the middle of the area to 

represent the thick door.  Note that the extra area attached to each room is neglected when the area of 

the room is reported in its property panel, but it is included during simulation. 
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Figure 3-20: Adding a thick door in the empty space between two rooms 

Door properties 

To edit a door’s properties, select the door.  Its properties will appear in the property panel as shown in 

Figure 3-21. 

 

Figure 3-21: Door property panel 

 Width: The width of the door. Changing this value will change the width of the door, but the 

value cannot exceed the length of its room edge. 

 Flowrate: Checking this box overrides the default door flowrate setting in the Simulation 

Parameters Dialog (see Parameters on page 73). Setting this value controls the maximum 

occupant flowrate for the door in units of pers/t. This could be used, for instance, to specify a 

gated mechanism, such as a turnstyle. A value of .9 pers/s, for instance, would mean that one 

occupant can go through the door every 1.1 seconds (1/.9). 

 One-way: The one-way direction of the door.  A One-way door is one in which occupants can 

only travel through it in one direction.1   

NOTE: Even though a door can only be travelled through in two possible directions, the drop-

down box allows +X, -X, +Y, and -Y.  When one of these directions is chosen, the actual direction 

Pathfinder chooses is the closest along the door’s normal.  

 State:  Indicates the timed opening and closing of the door. By default, all doors are always open 

throughout the simulation. To change this, click the link. The Edit Door State dialog will appear 

as shown in Figure 3-22.  This dialog allows the initial state of the door to be specified as well as 

additional timed states.  As shown in the figure, for example, the door is initially open, closes at 

t=10 s and then opens again at t=30 s. 

                                                           
1
 Occupants can ignore the one-way setting of doors if their profile has Ignore Oneway Door Restrictions checked. 

This allows them to go through in either direction. 
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Figure 3-22: Scripted Events dialog 

Stairs 
Stairs in Pathfinder are represented by one straight-run of steps.  They can be created with two tools.  

One tool allows creation of stairs between two semi-parallel boundaries of rooms, and the other allows 

creation of stairs that extend from one room boundary until a criterion is met, such as number of steps, 

height of stairs, etc, or until another room is reached.   

One requirement of all stairs for successful simulation is that each end of the stairs must connect to 

boundary edges of the rooms, meaning that there must be empty space at the top of the stairway and 

empty space below the bottom.  This requirement is shown in Figure 3-23.  The size of the gap must be 

greater than or equal to the radius of the largest occupant to travel on the stairs.  

  

(a) Shows a stair that will not simulate correctly (b) Shows a stair that will simulate correctly 

Figure 3-23: Stair geometry requirements 

Stairs between edges 

One way to create stairs is to draw them between two pre-existing rooms.  Stairs of this type will match 

the ends of the stairs exactly to the edges that they were drawn between, which means that the tread 
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rise and run may or may not match the actual slope of the stairs.  In Pathfinder, the geometric slope of 

stairs is unimportant in the simulation, but the specified tread rise and run are.  

To create stairs between edges, first ensure that both the connecting rooms are visible.  If the rooms are 

on different floors, at least one room will have to be manually set visible, which can be done through the 

right-click menu in the Navigation View.  Next select the two-point stair tool, . The property panel will 

display the stair creation properties as shown in Figure 3-24.  The stairs can now be created in one of the 

three following ways: 

 Manual Entry:  Set the desired stair width, and for each edge on which the stairs should be 

created, enter a point.  If the points are valid, a preview stair will be shown in the 2D or 3D view 

and the Create button will enable.  Click the Create button to add the stairs. 

 Two-click:  Set the desired stair width.  Move the cursor over the first edge, and a preview line 

similar to a thin door will appear previewing the top or bottom of the stairs.  Single-click to set 

the point.  Now move the cursor over the second edge.  Now a preview of the stairs will appear 

connecting the first edge to the second.  Single-click on the second edge to create the stairs. 

 Two-click with drag:  Click-drag on the first edge to specify both the starting point and width of 

the stairs.  Release the mouse and then single-click on the second edge to place the stairs. 

 

Figure 3-24: Property panel for the two-point stair tool 

   

Figure 3-25: Drawing stairs with the two-point stair tool 

Stairs extending from one edge 

Another way to create stairs is to have them extend from an edge and exactly match the specified tread 

rise and run.  They will stop when they meet a specified criterion or reach another room.  The property 

panel for the one-click stair tool, as shown in Figure 3-26, provides four ways to terminate the stairs: 
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 Step count: The stair will have this many steps. 

 Total rise: The stair will be this tall in the Z direction.  

 Total run: The stair will be this length in the XY plane. 

 Total length: The hypotenuse of the stair will be this length. 

 

Figure 3-26: Property panel for the one-point stair tool 

To create stairs in this manner, select the one-point stair tool, .  The property panel will show.  If the 

tread rise is positive, the stairs will extend up from the starting edge, and if it is negative, the stairs will 

go down.  Similarly, if the tread run is positive, the stairs will extend away from the room, and if it is 

negative, the stairs will extend in toward the room.  Another way to change these values is to hold CTRL 

on the keyboard to make the tread rise negative and hold SHIFT to make the run negative.  Now the 

stairs can be created in one of the three following ways: 

 Manual Entry:  Set the desired stair width, tread rise, tread run, and termination criterion.  

Specify the starting point on the desired edge.  If the location is valid, a preview stair will be 

shown, and the Create button will enable.  Click the button to create the stairs. 

 Single-click:  Set the desired stair width, tread rise, tread run, and termination criterion.  Move 

the cursor over the starting point on the room’s boundary.  A preview stair will be displayed.  

Single click to place the stairs. 

 Click-drag:  Set the desired tread rise, tread run, and termination criterion.  Now click-drag along 

the room’s boundary to specify both the location and the width of the stairs.  Release the mouse 

to create the stairs. 

 

Figure 3-27: Drawing stairs using the one-point stair tool 
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After creating stairs in this manner, the Z location of the next floor or room will have to match the top of 

the stairs exactly for the next room to connect properly to the stairs.  This can be done by clicking the 

top of the stairs in the 3D or 2D view when choosing the Z location for either the floor or next room. 

Stair properties 

Stairs have a number of properties that control their geometry and behavior of occupants that travel on 

them. When a stair is selected, these properties can be seen in the stair’s property panel as shown in 

Figure 3-28. 

 

Figure 3-28: Stair property panel 

 Riser and Tread: Together, these parameters control the speed at which occupants can travel on 

the stairs during simulation.  While the one-point stair tool uses the tread rise and run to create 

the initial shape of the stair, these properties can later be changed without affecting the stair 

shape. 

 Length:  The total length of the stair from the bottom to top edge. This is the same as the 

hypotenuse formed by the total stair rise and total stair run. 

 Width:  The width of the stair. 

 Top Door and Bottom Door: Clicking these links show the dialog in Figure 3-29. Here, properties 

of each implicit door can be edited independently of the other door, including Width, Flowrate, 

and State.  For more information on these properties, see Door properties on page 26. 

 One-way: Indicates whether the stair should only allow occupants to travel in one direction and 

if so, which direction. 

 Speed Modifier: A time-variable factor that affects the speed of occupants who travels on the 

stair. This acts the same as the Speed Modifier property for rooms (see Room properties on 

page 20). 

 Additional Info: Clicking this link shows additional information about the stair, such as its 

geometric bounding box, area, and number of occupants. 

 

Figure 3-29: Stair door property dialog 
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Ramps  
Ramps are nearly identical to stairs in how they are created and represented.  Like stairs, they have two 

implicit doors at either end and always take the shape of a rectangular piece of geometry.  They also 

have very similar creation tools: the two-point ramp tool, , and the one-point ramp tool, .  The key 

difference between ramps and stairs is that ramps do not affect the speed at which occupants travel. 

Escalators 
Pathfinder provides some limited support for escalators.  They are essentially stairs with slightly 

modified properties.  To create an escalator, perform the following: 

1. Create a stair as discussed previously.  

2. Select the stair (or several) so its properties are visible in the property panel as shown in Figure 

3-28. 

3. Set a one-way direction for the stair. 

4. Click the Speed Modifier drop-down, and choose Speed Constant as shown in Figure 3-30. 

5. Edit the speed of the escalator in the speed constant field. As with the Speed Modifier for stairs, 

the Speed Constant can be time-variable. This would normally be used to turn the escalators on 

or off throughout the simulation by using the values 1.0 and 0.0 respectively, but any value can 

be entered. 

 

  

Figure 3-30: Changing a stair into an escalator 

In the results view, escalators do not appear differently than stairs. 

By default, occupants do not walk on moving escalators. This can be changed by modifying the 

occupant’s profile and selecting Walk on Escalators (see Profiles).  This causes the escalator’s speed 

constant to be added to the occupant’s current speed on the escalator.  

NOTE: When escalators are turned off, occupants will use them as stairs, regardless of whether their 

profile indicates that they want to walk on escalators. 

Moving Walkways 
Pathfinder also provides limited support for moving walkways.  This is similar to creating escalators, but 

instead of setting a speed constant on an existing stair, the speed constant is set on a flat ramp instead.   



Pathfinder User Manual   

 

32 

Elevators 
Pathfinder supports elevators in egress-mode operation, which is based on current thinking described in 

Using Elevators In Fires1.  The basic operation of elevators in evacuations can be summarized as follows: 

 Each elevator has one discharge floor.  This is where the elevator starts at the beginning of the 

simulation and where it will take occupants it has picked up.  

 Each elevator has at least one pickup floor.  These are floors where the elevator will pick up 

occupants that it will take to the discharge floor.  

 An elevator is called on a pickup floor by an occupant when they come within .5 m of the 

elevator door. 

 The elevator uses a priority system to serve called floors.  By default, floors are served from top 

to bottom; however, other floors can be given higher priority to simulate fire floors. 

 When travelling to a pickup floor, the elevator can change to another pickup floor mid-flight if a 

higher-priority floor is called that is above the elevator’s current location. 

 Once an elevator has picked up occupants, it will only travel to the discharge floor before letting 

the occupants off.  It will not travel to any other floor to pick up more occupants. 

Creating elevators 

Elevators can be made after creating the rest of the model.  Perform the following steps to create the 

elevator (refer to Figure 3-31): 

1) Draw a room that defines the shape of the elevator, preferably on the discharge floor. 

2) Draw all doors on the boundary of the base room.  Occupants will use these doors on every floor 

to enter and exit the elevator. 

3) Right-click the base room, and from the right-click menu, select Create Elevator….  This will 

show the New Elevator dialog as shown in Figure 3-32. 

4) In the New Elevator dialog, enter all parameters for the elevator: 

 Name – the name of the elevator 

 Nominal Load – the number of people in a full load (estimated). Please read the 

Nominal Load section below for details. 

 Elevator Geometry – the base room that defines the elevator shape.  This defaults to 

the room that was originally selected. 

 Travel Direction – a vector defining the direction the elevator can travel.  This vector 

will automatically be normalized.  NOTE: the elevator can travel negatively against this 

vector. 

 Elevator Bounds – this defines the bottom-most and top-most floors the elevator can 

connect to. 

 Elevator Timing – this defines a basic timing model used to calculate the travel times for 

the elevator to travel from the discharge floor to each pickup floor. 

 Acceleration (Elevator Timing) – [optional] the acceleration of the elevator. 

                                                           
1
 Richard W. Bukowski and Fang Li, “Using Elevator In Fires,” Consulting – Specifying engineer, July 21, 2010. 
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 Max Velocity (Elevator Timing) – the maximum velocity that the elevator can accelerate 

to. 

 Open+Close Time (Elevator Timing) – the sum of the door opening and closing times.  

Each value will be taken as half of this. 

5) Press OK to create the elevator. 

If necessary, Pathfinder will automatically subtract holes in existing geometry to make space for the 

elevator shaft.  It will also delete existing rooms, doors, stairs, and ramps in the elevator shaft.  

Pathfinder will ask before making any of these changes. 

In order for occupants to use elevators, they must explicitly be told to do so through their behaviors, as 

discussed in Behaviors. 

NOTE: The timing values can be re-calculated using a new timing model by selecting the elevator, 

selecting Edit next to Level Data in the property panel, and then selecting Reset… in the level data 

dialog. 

 

Figure 3-31: Creating an Elevator 
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Figure 3-32: New Elevator dialog 

Elevator representation 

Once an elevator is created, it will appear in the model as a series of “rooms” and doors connected by a 

transparent elevator shaft as shown in Figure 3-33.  There is one room and set of doors for each floor to 

which the elevator can connect.  In the 3D and 2D Views, each room is shaped the same as the base 

room that created the elevator.  In the Navigation View, each room is shown under the elevator rather 

than the Floors top node.  In addition, each set of doors for the room is shown under the room.  By 

default, each of the rooms is named after the floor on which it connects.  If the elevator is disconnected 

completely from a floor as discussed in Connecting/Disconnecting floors, the room is named 

“<Disconnected Level>”. 

    

Figure 3-33: Elevator representation 
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Elevator properties 

Once an elevator is created, the elevator’s properties can be edited by first selecting it from the 

navigation view or by ALT-clicking one of its rooms from the 2D or 3D view.  Its properties can be edited 

in the property panel as shown in Figure 3-34. 

 

Figure 3-34: Elevator property panel 

 Nominal Load – the number of people in a full elevator load (estimated). Please read the 

Nominal Load section below for details. 

 Open Delay – the minimum amount of time an elevator’s doors will stay open on a pickup floor. 

 Close Delay – a delay for closing the elevator doors.   

 Discharge Floor – the floor at which occupants will discharge during an evacuation. 

 Floor Priority – the priority of the floors for pickup.  By default this is top-down.  This can be 

changed, however by clicking the text, which will show the Floor Priority dialog as shown in 

Figure 3-35.  This allows the simulation of a fire floor. 

 Level Data – click the button to edit timing for each floor.  This will open the Elevator Levels 

dialog as shown in Figure 3-36. 

o Delay – the time delay from the start of the simulation for when the elevator can start 

picking up occupants from a floor. This value does not affect the discharge floor. 

o Open+Close Time – the total of the door opening and closing time for this floor. 

o Pickup Time – the time for the elevator to travel from the discharge to the pickup floor.1 

o Discharge Time – the time for the elevator to travel from the pickup to the discharge 

floor.1 

o Reset – By selecting the Reset… option at the bottom of the dialog, an Elevator Timing 

dialog will open, allowing automated recalculation of the Level Data parameters. The 

timing options shown are the same as those shown when creating the elevator. 

                                                           
1
 The pickup and discharge times are calculated from the timing parameters entered in the New Elevator dialog 

when the elevator is created. 
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Figure 3-35: Elevator Priority dialog 

 

Figure 3-36: Elevator Levels dialog 

Nominal load 

The nominal load is an estimate of the number of people that represent a full elevator load. The default 

value is based on an estimate of how many occupants of default size (diameter = 45.58 cm) would 

normally fill the elevator in steering mode. Increasing or decreasing the nominal load will cause 

occupants' sizes to be scaled up or down while they are on the elevator. The scale factor (default: 1.0) is 

determined by a correlation to the density produced by the nominal load. This makes it possible to 

adjust loading while still accounting for differences in individual occupants' size. In steering mode, the 

geometry of the elevator can lead to reduced loads (e.g. if the elevator is 2.8 persons wide). Please 

verify that the resulting (post-simulation) elevator loads match elevator manufacturer 

recommendations. 

Connecting/Disconnecting floors 

When an elevator is created, by default it is connected to every floor its doors touch along the elevator 

shaft.  Individual elevator doors can be disabled, however, to prevent entering/exiting the elevator 

through those doors on specific floors.  To do so, right-click the elevator door on the desired floor from 

the Navigation View or 3D/2D View and select Disable from the right-click menu.  To re-enable it, right-
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click the door from the Navigation View and select Enable.  Alternatively, right-click an elevator level 

and select Disable to disconnect all the elevator’s doors on that level, effectively preventing the elevator 

from picking up occupants on that level. 

Call Sets 

By default, each elevator is called individually.  Elevators can be grouped into call sets, however, so that 

when one is called, all elevators in the call set respond and travel to the pickup level.  To create a call 

set, create a group in the top Elevators group, and add the desired elevators to the new group.  All 

elevators in the group will be in the same call set. 

 

Figure 3-37: Elevator call sets 

Exits 
In Pathfinder, exits are merely thin doors that exist on the boundary of the model.  An exit can only have 

a room on one of its sides. 

Exits are created in almost the same way as thin doors as discussed in the section, Thin doors.  The only 

difference is that the door must lie on an edge of a room, and the edge must not be shared between 

two rooms. 

Exit doors are displayed the same as thin doors except that they are green as shown in Figure 3-38. 

 

Figure 3-38: An exit door 
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Importing Files 
Pathfinder can import a number of image and geometry files to aid in both drawing and automatically 

extracting rooms.  This includes several image formats, DXF, DWG, FDS, and PyroSim files. 

Importing images 

Background images can be imported by clicking Add a Background Image… on the Model menu.  When 

clicked, a dialog will appear prompting for an image file.  The following image formats are currently 

supported: 

 GIF 

 JPG 

 PNG 

After a file is selected, a new dialog will appear as shown in Figure 3-39.  This dialog allows properties of 

the image to be specified so that the proper scaling, rotation, and offset can be applied.  To specify the 

scaling for the image, two points, A and B, and a distance between them can be specified.  To specify the 

rotation of the image, an angle can be input that specifies the angle of the vector from A to B with the 

vector (1,0,0).  As shown in the figure, the A->B vector should be 90 degrees from the X axis.  The image 

will automatically be rotated when finished.  Finally, an anchor point can be specified on the image that 

indicates where that point is located in 3D space. 
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Figure 3-39: Importing a background image 

The imported image is added to the “Imported Geometry->Background Images” group in the Navigation 

View.  The image can be edited and deleted from there.  In addition, any number of images can be 

added to any floor. 

Importing CAD files 

Pathfinder can also fully import files saved in AutoCAD’s Drawing Exchange Format (DXF) as well drawing 

(DWG) files.   

To import a DXF or DWG file, under the File menu, select Import… and select the desired file.  After 

selecting a file, a step-by-step dialog will open as shown in Figure 3-40. 

1. Units: The first prompt asks the user to select the base unit in which the CAD file was created.  If 

the drawing was saved in a more recent file format, the prompt will default to the stored unit 

type.  The dialog box shows the model’s width, depth, and height based on the selected unit as a 

guide for selecting the unit.  Selecting Next brings up the options prompt. 
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2. Options: The options prompt allows the user to specify more options for import.  Before this, 

Pathfinder will attempt to discern if the CAD file contains a 2D Floorplan or a 3D Model and will 

select default values for the options based on the detected type.    

 Lines – check to import lines in the file (default=checked only for floorplans)  

 Faces – check to import faces in the file (default=checked only for 3D models) 

 Move geometry to Z – if checked, all imported geometry will be offset so that the 

minimum Z lies in the specified Z plane (default=checked only for 2d floorplans). 

 Flatten so geometry lies in one plane – if checked, all geometry will be scaled in the Z 

dimension by a very small scale (1e-9).  This is useful for floorplans that have entities 

drawn in several planes.  This option will flatten them all into one plane. 

(default=checked only for 2d floorplans). 

 Add a blank rectangle to obscure lower floors – if checked, a solid rectangle of the 

specified color will be added to the model. This is useful to obscure geometry located on 

lower floors.  The imported rectangle will be excluded from floor extraction by default. 

(default=checked only for 2d floorplans). 

  

Figure 3-40: Dxf unit dialog box 

Choose Finish to import the file.  All imported elements will be added to the “Imported Geometry” node 

in the Navigation View.  The grouping structure will include the model level, the layer level, and all 

entities distributed within the layer.  If both lines and faces were included in import and an entity 

contained both lines and faces in the CAD file, the entity is split into two in Pathfinder - one with the 

lines, and one with the faces.  

NOTE: In versions prior to Pathfinder 2012.1, DXF import allowed a background image to be created that 

could be passed through to the 3D results viewer.  While this option is no longer available, both 

imported line and face data is now sent directly to the 3D results viewer instead, eliminating the need 

for a background image. 
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Importing Revit Files 

While Pathfinder cannot directly import Autodesk Revit files (RVT), there are two ways to export the 

data from Revit into a DWG that Pathfinder can read.   

 Revit to DWG (direct): The first method is to export a DWG directly from Revit, which can then 

be imported into Pathfinder.  While simple to perform and only requires Revit, this method 

loses all information about materials, including textures, due to Revit’s limited DWG support.  To 

do this in Revit Architecture 2014, perform the following: 

1. Open the desired RVT file within Revit Architecture. 

2. Click the Revit icon at the top left . 

3. Select Export->CAD Formats->DWG files. 

4. In the DWG Export dialog, for Export, select <In session view/sheet set>. 

5. For Show in list, select Views in the Model. 

6. Click the Check None button, and then in the view table, select the check box for 3D 

View: {3D} (Other views may be chosen, but the DWG will only contain entities 

visible in the selected views). 

7. Click the Next… button and choose a file name for the DWG file. 

8. Click OK to create the DWG. 

9. Import the DWG into Pathfinder. 

 Revit to FBX to AutoCAD to DWG:  This method requires both Revit and AutoCAD and does not 

perform a perfect conversion, but it retains some information about materials and texture 

coordinates.  The steps described here use Revit Architecture 2014 and AutoCAD 2014. 

1. Open the desired RVT file within Revit Architecture. 

2. Click the Revit icon at the top left . 

3. Select Export->FBX. 

4. Specify the desired filename and click Save. 

5. Open AutoCAD. 

6. On the Insert tab in the ribbon, select Import. 

7. Select the FBX file created by Revit. 

8. The FBX Import Options dialog will appear.  The following are recommended settings 

for the FBX import: 

 Import section: Make sure Objects and Materials are checked.  Lights and 

Cameras are unused in Pathfinder.   

 Assign Objects to Layers: any option may be selected, but By Material is a 

useful option for Pathfinder.   

 Unit Conversion: This section is somewhat misleading.  While the Current 

Drawing Unit is correct, the FBX file unit tends to be incorrect.  No matter what 

unit is displayed in the greyed-out text for FBX file units, the actual unit in the 

FBX file is always FOOT.  The appropriate values need to be specified to make 

the proper unit conversion.  For instance, if the current drawing unit is 

Millimeters, you can enter the value, 1 on the left and 304.8 on the right 

because there is 1 foot per 304.8 millimeters. 
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 Block: Uncheck Insert file as block. 

9. Click OK to finish the import.  You may receive a warning about the clip plane of the 

camera. 

10. Save the file as a DWG. 

11. Import the DWG into Pathfinder.    

Importing PyroSim and FDS files 

Both PyroSim and FDS files can be imported into Pathfinder.  To import one of these file types, select 

Import… under the File menu.  Then select the appropriate FDS or PSM file.  The imported geometry will 

be added to the Imported Geometry group.   

If the imported file contains holes, the holes will be automatically subtracted from the solid obstructions 

and discarded.  If the file contains grids, the grids will be intersected with each other as FDS would, and 

the remaining minimum Z faces of the grids will be imported.  If the file contains OPEN vents, the vents 

will be subtracted from the appropriate grid faces and discarded. 

Working with Imported Data 
Each type of file that can be imported provides an aid for creating navigation geometry.  The different 

types can be worked with in various ways to create the desired rooms, stairs, and doors.  Common to all 

import types is the ability to set some visual properties, such as color and opacity for each component of 

the geometry.   The imported geometry is sent as-is to 3D Results, resulting in a clean and fast graphical 

representation of the data. 

Working with Images 

Working with background images requires the user to draw all rooms, doors, and stairs over the 

background image.  Because the drawn navigation geometry will cover the background image, it may be 

preferable to make the navigation geometry transparent.  This can be accomplished by selecting the 

drawn navigation components and lowering the opacity in the property panel.  Figure 3-41 shows a 

background image with rooms and doors drawn on top, with a lowered opacity for the drawn rooms. 

 

Figure 3-41: Drawing rooms over a background image 
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To draw rooms on top of a background image, refer to the section, Rooms on page 16. 

Working with 3D CAD, PyroSim, and FDS files 

Because 3D CAD, PyroSim and FDS files import 3D data, they provide the most helpful information for 

accurately extracting navigation area.  Navigation area can be extracted on a room by room basis using 

the Extract floors tool ( ) from the 3D or 2D views.   

The tool properties for this tool are shown in Figure 3-42.  The Max Slope refers to the maximum grade 

that a person can walk on.  Only imported polygons that have a slope less than this will be included in 

the result.  Max Head Height refers to the maximum height of all the agents that will be included in the 

simulation.  This parameter is used to subtract overhead obstructions from the resulting room.  The Gap 

Tolerance provides some control in dealing with imperfections in the imported data. If walls are closer 

than the gap tolerance, Pathfinder will add an extra thin wall in that area, helping to split of rooms so 

the result does not bleed into undesired areas. 

 

Figure 3-42: Property panel for the floor extraction tool 

To extract a room using this tool, first select the tool from the 2D or 3D view.    Once the appropriate 

parameters have been chosen, either enter a location on the floor of the desired room into the property 

panel or click this point in the 3D or 2D view.  If this point does not have any overhead obstructions 

within Max Head Height and the point is on a polygon with a slope less than Max Slope, Pathfinder will 

march out from this point on the imported geometry’s polygons until it finds the boundaries of the 

room.  It will also subtract overhead obstructions within Max Head Height from the resulting room.  An 

example of an extracted room is shown in Figure 3-43.   

 

Figure 3-43: A room extracted from a PyroSim file 
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When using the 3D floor extraction tool, Pathfinder will include all imported geometry with faces, even 

if hidden.  If an object must be excluded from floor extraction, before performing extraction select the 

imported object and in the property panel, deselect Include in room extraction. 

Working with 2D DXFs 

2D DXF data can be worked with in two ways: it can be used as a guide for drawing rooms similarly to 

background images with the added benefit of being snapped to, or it can have rooms automatically 

extracted from it similarly to 3D imported geometry. 

To sketch the rooms using the built in drawing tools, refer to the section, Rooms on page 16. 

Automatic room extraction from 2D DXF data works similarly to extracting rooms from 3D DXF data.  As 

in 3D extraction, the Extract floors tool ( ) is used.  In addition, the user must click a point in the model 

with the tool, and one room will be automatically extracted.  The main difference from 3D extraction is 

that the clicked point must not lie on any 3D imported faces marked for floor extraction; instead it must 

be in empty space (or on the background rectangle imported with a 2d floorplan).  The clicked point 

should also be surrounded by imported 2D lines.  These lines will form the boundary of the resulting 

room.  For this reason, any lines that do not contribute to the room’s boundary, such as notations, 

symbols, etc. should be deleted, hidden, or excluded from floor extraction prior to clicking the 

extraction point.  To manually exclude imported geometry from floor extraction, select the geometry 

and from the property panel, deselect Include in room extraction. When determining which imported 

geometry to extract rooms from, the 2d room extraction tool will automatically exclude hidden objects 

and those manually excluded. 

Once the desired point is clicked, the surrounding 2D lines looking at the model from the Top View will 

be projected along the Z axis onto the active floor’s working Z plane.  These projected lines will then be 

used to define the room around the clicked point.  If the surrounding lines do not form a closed 

boundary as shown in Figure 3-44 (a), the resulting room will spill outside of the lines and form a room 

around the bounding box of all the lines as shown in Figure 3-44 (b).  In this case, this outer portion of 

the room can be separated from the inner portion using the Thin Wall tool as discussed in the section, 

Thin walls on page 18.  Once separated, the outer portion can be deleted. 

When the extraction tool is finished finding a room, the room will lie in the working Z plane of the active 

floor. 
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(a) (b) 

Figure 3-44: Room extraction results from an imported 2D Floorplan 

Filling in missing pieces 

Once rooms have been extracted using the 3D or 2D room extraction tools, the model will still be 

missing doors and stairs.  Doors and stairs must be added manually as discussed in the appropriate 

sections of this guide.   

One feature that may be of particular interest to help this process, however, is the internal door feature 

of the door tool.  This feature automatically finds areas within a room that look like potential doorways 

and can be used to create a thick door in this area.  To use this feature, select the door tool.  In the 

property panel for the tool as shown in Figure 3-18, the Max Width refers to the maximum width of the 

doorway to search for and Max Depth refers to the maximum thickness of the doorway.  These numbers 

may need to be larger than for the normal creation of a door to find potential doorways.  Once the 

appropriate parameters have been entered, move the cursor over the desired doorway.  A door preview 

will be displayed.  If it doesn’t, adjust the search parameters in the property panel and try again.  If the 

door appears correctly, left click the mouse button.  The doorway area of the room will be subtracted 

from the room, and the thick door will be created in its place.  The process is shown in Figure 3-45. 

  

Figure 3-45: Using the door tool to fill a doorway 
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Visual Characteristics 

Both 2D and 3D imported geometry have visual characteristics.  All geometry types have an object color 

and opacity.  Faces imported from a DWG, PSM, or FDS file may optionally have materials applied to 

them, which can define more advanced display properties such as texture images as discussed in 

Materials below.  If a face has a material applied, the material’s display settings override that of the 

object color and opacity when the Show Materials ( ) option is selected in the 2D View or the 3D View 

(see View Options on page 10). 

All display properties can be set through the properties panel when imported geometry is selected, as 

shown in Figure 3-46. 

 

Figure 3-46: Imported Geometry property panel 

 Visible: Whether the selected object is currently visible. 

 Include in room extraction: Whether the object should be considered when using the room 

extraction tool. 

 Material: The material applied to the selected faces when the Show Materials option is turned 

on.  Clicking the material button will open the Material Dialog as shown in Figure 3-47 on page 

47.  In this dialog, the material can either be edited or a new material can be applied to the 

faces by selecting one from the list on the left and pressing the OK button.  To remove the 

reference to the material, select the <No Material> option from the material list.  NOTE: 

Because materials can be shared among faces, editing a material applied to one face will also 

change the visual appearance of all faces referencing that material. 

 Color: The color of the selected objects when they have no material or the Show Materials 

option is turned off. 

 Opacity: The opacity of the selected objects when they have no material or the Show Materials 

option is turned off. 

Materials 

Materials define advanced display properties that can be applied to faces contained in the imported 

geometry.  They are only shown when the Show Materials ( ) option is selected in the 2D View or the 

3D View (see View Options on page 10).  Materials can be shared among faces; when a material is 

edited, all faces referencing that material are updated.   

Materials are extracted from import files in different ways, depending on the file type: 

 DWG: DWG files have a concept of materials.  Each material that is referenced by an object in 

the DWG file will be imported into Pathfinder.  Currently, Pathfinder supports the diffuse color, 

diffuse texture, and opacity setting of the material. 
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 FDS and PSM: Pathfinder materials are constructed from the color and texture settings of the 

surfaces in these file types. 

NOTE: The use of the word “material” in Pathfinder is different than in PyroSim and FDS.  In 

these applications, a material defines the physical properties of a substance.  In Pathfinder, a 

material defines the visual appearance of a face. 

To see the materials that have been imported from the DWG or PSM file, on the Model menu, select 

Manage Material Database….  The Material Dialog will appear as shown in Figure 3-47. 

 

Figure 3-47: Material dialog 

Pathfinder provides some default database materials.  Most of these materials start with the prefix, 

psm_ as in PyroSim.  Other materials were either created manually by the user or were imported with 

the CAD or PyroSim file.   

Materials can be added manually by clicking Import… under the material list.  Currently, a new material 

must be created from an image on disk that defines the texture of the material.  The image is copied 

into the database directory.  Newly created materials are added to the database, and can be used across 

instances of Pathfinder.   

Materials that were imported are only stored in the current Pathfinder file.  They are not available when 

a new model is created, and there is currently no way to import these into the database. 



Pathfinder User Manual   

 

48 

Materials can be deleted by clicking Remove… under the material list.  If the material exists in the 

database, all its associated files in the database directory will also be permanently removed.  

The following material properties can be edited: 

 Color: Selecting this option makes the material a solid color. 

 Texture Image: Selecting this option makes the material show a texture image. 

 Width and Height: Define the dimensions of the texture image in the model.  For instance, if the 

image depicts a 4x4 array of bricks with no motor between, and each brick is 8”x3”, the Width 

would be 32” and the height would be 12”. 

 Opacity: Defines the opacity of the material. 

Reorganizing and Making Fast Edits 

Sometimes the imported data may not be organized in a convenient manner.  For instance, it might be 

desirable to change some feature of all the windows, but the windows in the model may not be in the 

same group, making it difficult to select all of them at once.  In cases such as these, the similar objects 

may have the same color. If so, right click one of the objects, and choose Select All by Color.  

Alternatively, choose Select All by Material.  This will find all objects with the same color or material and 

select them, making it easy to change some shared property or move them into another group for easy 

selection later. 
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4. Creating Occupants 
In Pathfinder, occupants are defined in two parts: profiles and behaviors.  The profile defines fixed 

characteristics of the occupants, such as maximum speed, radius, avatar, and color.  The behavior 

defines a sequence of actions the occupant will take throughout the simulation, such as moving to a 

refuge area, waiting, and then exiting. 

Profiles 
Pathfinder uses an occupant profile system to manage distributions of parameters across groups of 

occupants.  This system helps you control the occupant speed, size, and visual distributions.  To edit 

occupant profiles, you can use the Edit Profiles dialog (Figure 4-1). 

To open the Edit Profiles dialog: on the Model menu, click Edit Profiles... 

 

Figure 4-1: The Edit Profiles dialog 

The Description box provides a place to enter descriptive text.  This value is not used outside the Edit 

Profiles dialog. 

The 3D Model input provides a way to use a specific set of 3D human models for an occupant profile.  To 

select 3D models, click Edit... on the 3D Model row.  This will open the 3D Models dialog (see Figure 

4-2).  When rendering occupants as 3D human models belonging to the current profile, Pathfinder will 

choose one of the 3D models selected in the 3D Model dialog.  To enable or disable a particular model, 

click the model's icon. 
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Figure 4-2: An example of the 3D model dialog. 

The Characteristics tab provides the following parameters: 

 Priority Level:  the priority of the occupant.  Higher values indicate higher priority.  This allows 

occupants of lower priority to move out of the way of those of higher priority.  This would be 

useful when simulating first responders that must be able to move easily through a crowd of 

occupants.  Priority values are completely relative.  For instance, if three occupants meet of 

priorities 4, 6, and 12, they will behave the same as if their priorities were 0, 1, and 2, 

respectively. 

 Speed: specifies the maximum speed an occupant may travel in an open room with speed 

modifier set to 1.0. 

 Shoulder Width: the diameter of the cylinder representing the occupant.  This is used for 

collision testing and path planning during the simulation.  This value will also affect how many 

occupants can be added to a room without overlapping. 

The Movement tab provides parameters related to how occupants use their surroundings: 

 Use Stairs:  whether the occupant can use stairs to evacuate. This may be useful to model 

occupants with physical impairments. 

 Ignore Oneway Door Restrictions:  whether the occupant will ignore the direction specified for 

one-way doors. If this is unchecked, the occupant will only travel in the direction indicated for 

the door. If this is checked, the occupant may go either way through any door. 

 Walk on Escalators:  whether the occupant will walk on escalators and moving walkways. If this 

is checked, the escalator’s speed constant will be added to the occupant’s desired speed on the 

stair to determine the occupant’s final speed. If unchecked, the occupant will stand still and 

travel on the stair at the stair’s speed constant. 



Pathfinder User Manual   

 

51 

The Door Choice tab provides parameters related to how occupants choose doors to exit from in each 

room. For more information about door choice, see the Pathfinder Technical Reference. 

 Current Room Travel Time:  a cost factor that affects the cost of travelling to a door in the 

occupant’s current room, ignoring all other occupants. Higher values increase the door’s cost in 

this category. 

 Current Room Queue Time:  a cost factor that affects the cost of waiting in a queue at a door in 

the occupant’s current room.  Higher values increase the door’s cost in this category. 

 Global Travel Time:  a cost factor that affects the cost of travelling from a door to an exit or the 

occupant’s next goal, ignoring all other occupants.  Higher values increase the door’s cost in this 

category. 

 Current Door Preference:  a value used to make occupants stick to their currently chosen doors, 

preventing excessive door switching.  A value of 100% will cause occupants to never switch 

doors once an initial door is chosen, and a value of 0% will allow occupants to freely change 

their selected doors. 

 Current Room Distance Penalty:  this value is used to exponentially increase the cost associated 

with travelling based on how far the occupant has travelled in the current room.  This causes the 

occupant to prefer shorter routes over faster routes the further they have travelled in the 

current room.  Every time the occupant travels this distance in the current room, the travel time 

cost will have doubled.  Setting this value to zero will disable this feature. 

The Output tab provides the following parameter: 

 Print CSV Data: When checked, an additional output file will be created for each occupant using 

this profile.  The file contains data for each time step, such as occupant speed, location, etc. For 

more information, see Occupant History on page 82. 

NOTE: Because this feature creates a file for each occupant with the profile, each containing 

several pieces of data for each output time step, it may cause the simulation to use significantly 

more resources, including CPU and disk space.  It may be better to only enable this feature for 

specific occupants. To do this, see Customizing Occupants on page 53.  

The Advanced tab provides the following parameters: 

 Height:  the height of the cylinder used for inter-occupant collisions.  This is useful for limiting 

collisions that might occur between occupants on different floors when the floors have been 

modeled close together. 

 Acceleration Time: a Steering Mode parameter that specifies the amount of time it takes for the 

occupant to reach maximum speed from rest or to reach rest from maximum speed. The 

resulting acceleration of each occupant is max_speed/accel_time. 

NOTE: This value has a significant impact on door flowrates and total evacuation times.  Versions 

of Pathfinder prior to 2013 used a fixed acceleration time of .5 s for all occupants, which 

resulted in high door flowrates.  The new default of 1.1 s results in flowrates closer to those in 

SFPE mode. 



Pathfinder User Manual   

 

52 

 Reduction Factor:  a Steering Mode Parameter that specifies how well an occupant may squeeze 

past others in tight corridors.  This factor should be specified as greater than 0 and less than or 

equal to 1.  This factor is directly multiplied by the shoulder width during calculations, so a 

Reduction Factor of 0.5 would lead to the occupant being able to squeeze to one-half his 

shoulder width. 

 Comfort Distance:  specifies the desired distance one occupant will try to maintain with others 

nearby such as when waiting in queues. 

 Persist Time:  The amount of time an occupant will maintain an elevated priority when trying to 

resolve movement conflicts.  See the Technical Reference for more details. 

 Collision Response Time:  when multiplied by an occupant’s current speed, this parameter 

controls the distance at which an occupant will start recording a cost for colliding with other 

occupants when steering. 

 Slow Factor:  specifies a fraction of the occupant’s speed at which they are considered to be 

slow.  A slow occupant will consider backward directions to separate with others, while a fast 

moving occupant has a tighter, more focused direction. 

Each of these parameters (except on/off parameters) can be set using a constant value, a uniform 

distribution between two values, or either a normal (Gaussian) or log-normal distribution using a min, 

max, standard deviation, and mean.  

Each occupant in the Pathfinder model is linked to one profile.  Profile parameters can be edited in the 

profiles dialog at any time and the occupants using that profile will be automatically updated.  

Occupants’ profiles can be set when adding the occupants or by selecting the occupants after being 

created and editing the Profile box in the property panel. 

Seeds 

Each occupant has a unique random seed that determines the specific values generated from a profile 

distribution.  Each of these occupant-specific values can be seen by selecting an individual occupant.  

These specific values will never change unless the distribution is changed in the profile or a new seed is 

manually generated for the occupant.  This ensures that two simulation runs with the same input model 

will give the same answer.  New seeds can be generated for occupants by right-clicking the occupants 

and selecting Randomize. 

For an example of the effects of the changing the seed or profile, consider the following scenario: 

1. A profile has been created using a uniform distribution of speed on the range 1 m/s to 2 m/s. 

2. An occupant is created using this profile. 

3. Using the occupant’s unique random seed, Pathfinder assigns the occupant a speed of 1.6 m/s 

based on the occupant’s profile. 

4. The simulation is run several times, and each time the occupant has a maximum speed of 1.6 

m/s. 

5. The occupant’s profile is changed so that its speed range is .5 m/s to 1 m/s. 
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6. Pathfinder assigns the occupant a new maximum speed of .6 m/s, which is used for all 

subsequent simulations. 

7. The user randomizes the occupant, and Pathfinder assigns a new maximum speed of .91 m/s to 

the occupant. 

Customizing Occupants 

When occupants are selected, their property panel appears as shown in Figure 4-3.  Occupants can be 

given custom profile data once they are added to the model.  This can be done by selecting a set of 

occupants and checking the box next to the parameter to be customized.1  

When using custom profile data, only constant values can be used for occupant parameters.  In addition, 

once a parameter is customized, any changes to that parameter in the profile will not affect the 

customized value. 

 

Figure 4-3: Using a custom occupant profile 

Occupants with individually customized parameters can easily be found by right-clicking all or a sub-set 

of occupants and selecting Select Customized Occupants from the right-click menu if any exist in the 

selection. 

Behaviors 
Behaviors in Pathfinder represent a sequence of actions the occupant will take throughout the 

simulation.  For every behavior, there is an implicit action to move the occupant to an exit.  This implicit 

action will always happen last.  Additional intermediate actions may also be added that can make the 

occupant wait or travel to a non-exit destination, such as a room or point.  By default, there is one 

behavior in the model called “Goto Any Exit.”  This behavior simply makes the occupant move from their 

starting position to any exit present in the model by the fastest route.   

As with profiles, any number of occupants can refer to a single behavior.  Any changes to the behavior 

will be reflected in referring occupants. 

Creating a new Behavior 

To create a new behavior, right click the Behaviors node from the Navigation View, and from the right-

click menu, click Add a Behavior…, which will open the New Behavior dialog shown in Figure 4-4.  In the 

New Behavior dialog, enter a behavior name, and optionally specify an existing behavior to base the 

new behavior on.  Using this option will copy all the actions from the existing behavior. 

                                                           
1
 In versions of Pathfinder prior to 2012.1, individual parameters could not be customized. If one parameter was to 

be customized, all had to be customized. 
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Figure 4-4: New Behavior dialog 

With the new behavior selected, the behavior property panel will appear as shown in Figure 4-5.  

 

Figure 4-5: Behavior Property Panel 

 Initial Delay – This specifies an initial delay that makes the occupant wait at their starting 

position before moving to the next action.  If this link is clicked, it will show a dialog where 

different distribution curves can be entered for the delay, similar to those discussed in Profiles. 

 Exits – This specifies a set of exit doors the occupant is allowed to exit through during their final 

implicit exit action.  Clicking this link will open the exit chooser, as shown in Figure 4-6. 

 

Figure 4-6: Exit Chooser dialog 

Adding actions 

Additional actions can be added to any behavior, such as going to a room, a waypoint, an elevator, or 

simply waiting in place.  To add an action, select a behavior or existing behavior action.  The property 

panel (Figure 4-5) will show a drop-down button with the description of an action that can be added.  To 

add the currently shown action, simply click the button.  To add a different action, click the down-arrow 

shown to the right of the button and select the desired action from the behavior actions list. 
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Figure 4-7: Behavior actions list 

Once the desired action is clicked, a creation panel will be shown above the 3D/2D View depending on 

the action.  Enter the desired parameters in the creation panel as discussed in the following sections, 

and then click Create to create the action and append it to the behavior.  If the behavior itself was 

selected when adding the action, then the new action will be appended to the end of the list.  If, instead, 

an action was selected when the new action was created, then the new action is inserted directly after 

that selected action.   

Actions always occur in the order shown in the Navigation View.  For instance, as shown in Figure 4-8, an 

occupant using “Behavior1” would first go to any elevator, then go to “Room00”, then wait for 20 

seconds, then go to “Room09”, and finally exit.  The actions can be reordered at any time (except 

exiting) by dragging and dropping an action in the list in the Navigation View. 

 

Figure 4-8: Example of action order for a behavior 

Goto Waypoint action 

A Goto Waypoint action specifies that an occupant should go toward a specific point on the navigation 

mesh.  Once they arrive within a certain radius of the point, they will move on to the next action in their 

behavior.   

To add one of these actions, click the Add Goto Waypoint… button from the behavior actions list.  When 

adding the waypoint, the creation panel will look like Figure 4-9.  The Location specifies where the 

occupant must head.  This must be a point on the navigation mesh.  The Arrival Radius defines a circular 

area around the point.  These parameters can be entered manually in the creation panel or be filled in 

by clicking a point on the navigation mesh in the 3D or 2D View or click-dragging to specify the 

location+arrival radius.  When clicking or click-dragging, the action is created when the mouse button is 

released. 



Pathfinder User Manual   

 

56 

 

Figure 4-9: Goto Waypoint creation panel 

Goto Rooms action 

A Goto Rooms action specifies that an occupant must select a room out of a set, and go to it.  Once they 

cross a door into the room, they is considered to be in the room and can move on to the next action in 

their behavior.   If multiple rooms are specified for the action, the occupant will go to the one that is 

fastest for him to reach. 

To add a Goto Rooms action, click the Add Goto Rooms… button from the behavior actions list.  The 

creation panel will appear as in Figure 4-10.  Either click the Rooms link to specify the rooms with a 

dialog or left-click the desired rooms in the 3D or 2D View.  Right-click in the 3D/2D View to finish 

selecting the rooms and create the action, or click Create. 

 

Figure 4-10: Goto Rooms creation panel 

Goto Elevators action 

A Goto Elevators action tells an occupant to use evacuation elevators.  When using this action, an 

occupant will go to a specified elevator, call it, wait for it to arrive, enter it, and then wait for it to reach 

the discharge floor.  Once they reach the discharge floor, they can begin their next action.  The Goto 

Elevators action can only be used for occupants who are not on the discharge floor of the desired 

elevator.  If multiple elevators are specified for the action, the occupant will use the one that allows 

them to reach the discharge floor fastest. 

To add a Goto Elevators action, click the Add Goto Elevators… button from the behavior actions list.  The 

creation panel will appear as in Figure 4-11.  Either click the Elevators link to specify the desired 

elevators with a dialog or left-click the desired elevators in the 3D or 2D View.  Right-click in the 3D/2D 

View to finish selecting the elevators and create the action, or click Create. 

 

Figure 4-11: Goto Elevators creation panel 
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Wait action 

A Wait action tells an occupant to wait in their current location for a certain amount of time.  Once that 

time has elapsed they will begin their next action.   

The manner in which they wait will vary depending on their most recent destination.  For instance, if 

their previous destination was a waypoint, they will try to stay close to the center of the waypoint.  If 

the previous destination was a room, they will try to move toward a wall of the room, away from all 

doors.  This allows other occupants to enter the room.  If their previous destination is an elevator, they 

will first move toward the walls as in waiting in a room, and then stand still when the elevator travels.  In 

all cases, a waiting occupant will move out of the way of occupants headed toward a destination unless 

the destination overlaps with the waiting occupant’s most recent destination. 

To add a Wait action, click Add Wait from the behavior actions list.  The creation panel is shown in 

Figure 4-12.  The Wait Time specifies the amount of time they will wait at their current location. 

 

Figure 4-12: Wait creation panel 

Adding Occupants 
Occupants can be placed individually in the 3D or 2D view, distributed in a rectangular region of a 

particular room, or distributed through the entire area of a room or multiple rooms. 

Individual placement 

Individual occupants can be added to the model with the Add Occupant tool, . Occupants can only be 

placed in pre-existing rooms and stairs and cannot overlap other occupants or room boundaries.  Left-

click a desired position with the mouse, or enter an x-y-z coordinate and press the Create button from 

the property panel to place an occupant. 

 

Figure 4-13: Adding occupants individually 
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Group Placement 

Groups of occupants can be added to the model with the Add Occupant Group tool ( ). The occupants 

are distributed throughout this region using parameters in the property panel as shown in Figure 4-14: 

 Random/Uniform Placement: Random placement places occupants randomly within the 

designated area, such that no overlapping of occupants occurs. If the number of desired 

occupants is too great to accomplish this, a prompt will ask whether or not to continue with 

overlapping occupants.  Uniform placement places occupants in an orderly hex pattern, 

allowing greater occupant densities before overlap occurs. Again, a prompt will ask whether to 

continue with overlap if the density is too great. 

 Count/Density: This option specifies whether to place a set number of occupants or place 

enough occupants to achieve a certain density. Several template densities are provided, and 

Custom can be selected from the densities drop-down menu to enter a new value. 

 Profile: This option allows a distribution of profiles to be set for the occupants, such as 

specifying that 25% of the added occupants should be females < 30 years old, 30% children, etc.  

The label shows the currently set distribution, and if there is more than one profile defined in 

the model, the value can be clicked to edit the distribution.  This will open a dialog as shown in 

Figure 4-15. 

 Behavior: Like the Profile option, this option allows the distribution of behaviors to be set. 

  

Figure 4-14: Add Rectangular Group of Occupants Property Panel 

 

Figure 4-15: Editing the distribution of profiles 

Once the properties have been set, click-drag to draw the filling rectangle. Both points of the rectangle 

must lie in the same room. 
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Figure 4-16: Distributing occupants in a rectangular region 

When any occupants are selected, the property panel allows the occupants’ name, profile, behavior, and 

color to be edited. The occupants’ speed, time delay, and size are also displayed from the occupant’s 

profile, and can be made editable by selecting Custom from the profile drop-down menu. 

Placement in rooms 

In addition to distributing occupants in placement regions, occupants can be distributed throughout 

entire rooms.  To do this, select the desired rooms and choose Add Occupants… from the Model menu 

or the right-click menu as shown in Figure 4-17. This will bring up the Add Occupants dialog. For an 

explanation of the dialog’s options, please see the section, Group Placement. Click the OK button after 

selecting the desired options to place occupants and exit the dialog. 

  

Figure 4-17: Distributing occupants through entire rooms 

Redistributing Profiles and Behaviors 
Once occupants have been created, the distribution of profiles and behaviors can be reshuffled among 

them.  To do so, select one or more groups of occupants from the Navigation View, right-click them, and 

from the right-click menu, select Properties…, or double-click the occupant group.  The Edit Group 

Distributions dialog will appear as shown in Figure 4-18.  If more than one profile exists in the model, the 
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Profile link can be clicked to edit the distribution as discussed in Group Placement.  If more than one 

behavior exists in the model, the Behavior link can be clicked to edit its distribution. 

NOTE: Changing the distribution of profiles or behaviors will not change the number of occupants in the 

group.  It will just change which profile/behavior is assigned to each occupant to match the specified 

distribution as closely as possible. 

 

Figure 4-18: Edit Group Distributions dialog 
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5. Editing and Copying Objects 
Most objects can be edited in two ways in Pathfinder.  One way is to transform the object, including 

rotating, translating (moving), and mirroring it.  Another way is to graphically manipulate the objects by 

dragging handles.  Objects can also be copied, but currently the only way to do this is through the 

transform tools as discussed in the following section. 

Transforming and Copying Objects 
All geometric objects can be transformed and/or copied.  All transform/copy options are available 

through tools in the 3D and 2D views.  The following transforms are available and are discussed in the 

following sections:  moving, rotating, and mirroring. 

Moving 

To move one or more objects, select the objects and click the move tool ( ) from the 2D or 3D view.  

The property panel for the move tool is shown in Figure 5-1.   

 

Figure 5-1: Property panel for the translate tool 

The object can be moved either manually or graphically: 

 Manually:  Select Normal Mode and enter the distance to offset the object in the Move X, Y, 

and Z boxes.  Then click Move. 

 Graphically:  This is performed most easily in one of the 2D views.  To translate graphically click 

two points on the model.  The vector from the first point to the second defines the movement 

offset.  When moving graphically, objects will only be moved parallel to the camera’s view 

plane.  The steps for translating graphically are shown in Figure 5-2. 
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Figure 5-2: Graphically moving an object 

Objects can also be copied using the move tool.  To do so, select the move tool, select Copy Mode from 

the property panel, and follow the same steps as above for moving an object.  Alternatively, hold CTRL 

on the keyboard while defining the offset.  This will create a copy of the object that has been offset by 

the move distance.  Similarly, an array of objects can be made by specifying a value greater than 1 for 

the Copies field in the property panel.  The array is created by offsetting each previous copy by the 

move distance.  If, when copying rooms, the resulting copies overlap one another the most recent 

copies take precedence over earlier ones, meaning that earlier ones will have area subtracted from 

them.  An array is shown in Figure 5-3. 

  

Figure 5-3: Creating an array of objects by using the translate tool 

Rotating 

To rotate one or more objects, select the objects and click the rotate tool ( ) from the 2D or 3D view.  

The property panel for the rotate tool is shown in Figure 5-4.   
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Figure 5-4: Property panel for the rotate tool 

The object can be rotated either manually or graphically: 

 Manually:  Select Normal Mode and enter the base of rotation, the axis about which to rotate 

using the right-hand rule, and the angle to rotate.  Then click Rotate. 

 Graphically:  This is performed most easily in one of the 2D views.  The rotate axis is 

automatically set to a vector normal to the camera.  Rotating requires three mouse clicks.  The 

first specifies the base of rotation.  The second defines a reference vector extending from the 

rotation base.  The third defines a second vector extending from the rotation base.  The rotation 

angle is the angle between these two vectors.  The steps for rotating graphically are shown in 

Figure 5-5. 

 

 

Figure 5-5: Rotating an object 
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Objects can also be copied using the rotate tool.  To do so, select the rotate tool, select Copy Mode from 

the property panel, and follow the same steps as above for rotating an object.  Alternatively, hold CTRL 

on the keyboard while defining the rotate properties.  This will create a copy of the object that has been 

rotated from the original using the rotate parameters.  Similarly, an array of objects can be made by 

specifying a value greater than 1 for the Copies field in the property panel.  The array is created by 

rotating each previous copy by the rotate angle.  If copying rooms and resulting copies overlap one 

another the most recent copies take precedence over earlier ones, meaning that earlier ones will have 

area subtracted from them.  An array is shown in Figure 5-6. 

  

Figure 5-6: Creating an array of objects using the rotate tool 

Mirroring 

To mirror one or more objects about a plane, select the objects and click the mirror tool ( ) from the 

2D or 3D view.  The property panel for the mirror tool is shown in Figure 5-7.   

 

Figure 5-7: Property panel for the mirror tool 

The object can be mirrored either manually or graphically: 

 Manually:  Select Normal Mode and enter the plane about which to mirror.  This can be an axis-

aligned plane or a custom plane specified by the plane equation, ax + by + cy + d = 0.  Next click 

Mirror. 

 Graphically:  This is performed most easily in one of the 2D views.  The mirror plane is always 

perpendicular to the camera’s view plane.  Defining the plane requires two mouse clicks that 

define two points in the plane.  The steps for mirroring graphically are shown in Figure 5-8. 
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Figure 5-8: Mirroring an object 

Objects can also be copied using the mirror tool.  To do so, select the mirror tool, select Copy Mode 

from the property panel, and follow the same steps as above for mirroring an object.  Alternatively, hold 

CTRL on the keyboard while defining the mirror plane.  This will create a copy of the object that has 

been mirrored from the original using the mirror plane.   

Manipulating Objects with Handles 
Some objects, including occupants, rooms, stairs, and doors, can be edited through manipulator 

handles.  Handles act as points on an object that can either be dragged with the selection tool or edited 

by the keyboard to edit the attached object.  Handles only appear on selected objects and show as blue 

dots as shown in Figure 5-9. 

 

Figure 5-9: Manipulator handles 

Selecting and deselecting a handle 

To select an object’s handle, the object itself must first be selected.  Once it is selected, the blue handles 

should appear.  Next select the Select/Edit tool ( ).  Now an individual handle can be selected by 

clicking it, which will make the handle property panel appear as shown in Figure 5-10.  To deselect the 

handle, press Escape on the keyboard, click anywhere else in the model, or select another object. 
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Figure 5-10: Handle property panel 

Editing a handle 

A handle can be edited in one of two ways: it can be edited with the keyboard to enter precise values or 

it can be edited graphically. 

 Editing with the keyboard:  to edit with the keyboard, a handle must first be selected.  Next 

enter the desired location in the X, Y, and Z fields in the property panel and select the Commit 

button.  The handle will attempt to modify the underlying object using the handle’s internal 

constraints that are described in the appropriate section of this guide for the respective handle’s 

object. 

 Editing graphically:  a handle does not have to be selected before editing graphically.  To edit 

graphically, make sure the Select/Edit tool is selected, and press the left mouse button over the 

desired handle and drag the handle to the desired location.  Release the left mouse button, and 

the object will be edited.  A real-time preview of the object being edited will be shown as the 

mouse is dragged. 

Room handles 

When rooms are selected, a handle can be found at every vertex on the boundary of the room.  The 

handles move the underlying vertex to reshape the room.  The handles can be moved to any location 

within the plane of the face the vertex is on.  If the vertex is shared between two faces in non-parallel 

planes, the handle can only be moved along the edge to which it is attached. 

Thin door handles 

When a thin door is selected, three handles will be displayed as shown in Figure 5-11 (a).  The handles 

on the ends of the door allow the door to be moved along the edge to which it is attached.   The middle 

handle allows the door to be made thick by moving the handle to the edge of another room as shown in 

Figure 5-11 (b). 

  
(a) (b) 

Figure 5-11: Door handles 
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Thick door handles 

When a thick door is selected, six handles will be displayed as shown in Figure 5-11 (b).  The four 

handles on the corners of the door allow the door to be moved along the edge to which each handle is 

attached.  Each middle handle allows the door to be made into a thin door by dragging to the other 

middle handle.  The middle handle can also be useful to reattach the door to a room if the door 

somehow became detached (such as by a modification to the room). 

Stair and Ramp handles 

When a stair or ramp is selected, six handles will be displayed as shown in Figure 5-12.  The four corner 

handles each allow the stair/ramp to be moved along the edge to which the handle is attached.  The 

middle handles allow the stair/ramp to be reconnected to another room.  The middle handles can also 

be useful if the geometry of one room attached to a stair/ramp has changed in such a way that the 

stair/ramp is no longer attached to the room.  The middle handle can be used in this case to reconnect 

to the room. 

 

Figure 5-12: Stair/ramp handles 

Occupant handles 

When an occupant is selected, there is only one handle as shown in Figure 5-13.  The sole purpose of 

this handle is to move the agent to another location.  Moving an agent in this manner has a benefit over 

the translation tool in that the location automatically snaps to an existing room or stair as when adding 

an agent using the agent dropper tool. 

 

Figure 5-13: Agent handles 
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Waypoint handles 

When a waypoint is selected, five handles are displayed as shown in Figure 5-14.  The center handle 

allows the waypoint to be moved to another location similarly to the occupant handle.  The four handles 

on the perimeter of the circle can be used to change the arrival radius of the waypoint. 

 

Figure 5-14: Waypoint handles 
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6. Model Analysis 
Pathfinder contains some useful tools to analyze various properties of a model. 

Measuring Distances 
Distances can be measured by using the measuring tool ( ).  To do so, select the measuring tool from 

the 3D or 2D view.  Left-click a series of points to define a path along which to measure a distance.  

When done defining points, right-click.  The cumulative point-to-point distance is displayed in a dialog 

box. 

When measuring distances in the 3D view, the distance is taken as the actual distance between snapped 

points.  When measuring distances in the 2D view, however, the distance is taken by projecting the 

points onto a plane parallel to the camera view plane, and then taking the distance. 

Checking Connectivity 
Sometimes it is desirable to check how various components are connected in the model to debug 

simulation errors or to ensure model validity.  For instance, a model might contain two rooms connected 

by a hallway as shown in Figure 6-1. 

 

Figure 6-1: Connectivity example 

If a user attempts to simulate this model, the following error appears: 
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This type of error usually indicates that the model is not properly connected.  It is telling us that the 

occupant named “00001” cannot reach any of their assigned exits.  This means that either a connecting 

door is missing along their route to the exit or some other problem has occurred with the geometry.  We 

need to determine why the occupant cannot reach the exit on the right side of the model.  To do so, we 

right-click the room containing the occupant, and click Select Connected Components from the right-

click menu.  The following dialog is shown: 

 

Figure 6-2: Select Connected Components dialog 

We want to trace model connectivity as far as possible to determine where we might be missing a door 

or other connection, so from the drop-down box in the Select Connected Components dialog, we choose 

Entire graph and click OK.  Pathfinder will highlight the entire graph of components touching the initial 

selection as shown in Figure 6-3. 
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Figure 6-3: Selecting an entire graph of connected components 

From the selection, we can see that the hallway does not connect to the far-right room.  Upon further 

inspection, we can see that we do not have a door between the hallway and the room.  We can add a 

door to fix the problem. 

From the Select Connected Components dialog, we could have also chosen to select only immediately 

adjacent components.  This would have only selected the original room and the door between the room 

and the hallway.  This allows finer inspection of connectivity in a highly connected model. 

Checking in-use Objects 
In Pathfinder, there are several objects that can refer to other objects in the model.  For instance, an 

occupant can refer to both a profile and a behavior, a behavior can refer to exits, the goto elevators 

action can refer to elevators, etc.  There are times when it is useful to know what objects are referring to 

another.  For instance, it may be important to know which occupants are using a particular behavior.  To 

do this, right click the behavior (or other in-use object), and from the right-click menu, click Select 

Referencing Objects.  This will highlight all objects currently using that behavior. 

Warnings and Errors 
Pathfinder shows warnings and errors in the Navigation Tree to help debug potential errors in the 

simulation.  These warnings appear as a small exclamation mark imposed over an occupant or record, 

.  By hovering the mouse over the warning, a more detailed description of the problem can be 

determined.   For convenience, if an object has problems, the warning marker is propagated up through 

the navigation tree to its ancestor groups in order to quickly identify problems in the model.  Some 

common warnings include: 

 Warning if stairs are not connected to rooms at both ends. 

 Warning if stairs or doors overlap along an edge. 
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 Warning if stairs or doors create a non-manifold topology (e.g. a stair connects to the 

inside of a room rather than an outer wall or connects to two rooms on one of its ends). 

Problematic objects can be quickly selected by right clicking a group in the tree that has a warning or 

error icon, and selecting either Select Errors or Select Warnings from the right-click menu.  In addition, 

if the warning on a component indicates that it interferes or overlaps with other components, the 

objects with which it interferes can be quickly selecting by right-clicking the object with the warning and 

selecting Select conflicting components from the right-click menu. 

As a general note, if the warning “Edge is adjacent to more than 2 triangles” appears when simulating, 

an option to click Cancel appears to highlight the navigation components causing the warning. 
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7. Simulating 

Parameters 
The Simulation Parameters dialog provides a way to control certain features of the simulation, as well as 

provide some default values. 

Time Parameters 

 

Figure 7-1: The Time tab of the Simulation Parameters dialog 

The Time tab provides the following options: 

 Time Limit: can be used to automatically stop the simulation after a set simulation time. 

 Time Step Size: controls the resolution of simulation time steps.  Increase the time step size to 

speed up simulations, reduce the time step size to ensure simulation accuracy. 

Output Parameters 

 

Figure 7-2: The Output tab of the Simulation Parameters dialog 

The Output tab provides the following options: 

 3D Output Freq: controls the time between 3D output file updates.  Increasing this value causes 

data to be written less often, leading to less disk usage and run faster simulations (no file write 
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delay), but can produce a misleading 3D results visualization.  In the 3D results visualization, 

occupants will move in a straight line between two data points - if the two points are far apart in 

time, an occupant might appear to pass through an obstruction when it actually navigated 

properly. 

 CSV Output Freq: controls the time between CSV output file updates.  Increasing the value 

causes fewer rows to appear in the resulting CSV files (i.e. lower data resolution).  This option 

has a negligible effect on simulation performance or disk usage, but can affect performance in 

the 2D results. 

 Runtime Output Freq: controls the time between simulation status updates in the Run 

Simulation dialog.  This option has a negligible effect on simulation performance or disk usage. 

 Jam Velocity: controls the speed threshold at which occupants are recorded as being jammed in 

the Occupants output file. 

The Paths tab provides the following options: 

 

Figure 7-3: The Paths tab of the Simulation Parameters dialog 

 Max Agent Radius Trim Error: this parameter affects how accurately occupants can navigate 

through tight spaces when the occupants in the simulation have varying sizes.  The larger this 

value is the less likely an occupant is to navigate through a space that has a width close to their 

body diameter.  With larger values, however, the simulation will consume less memory and start 

faster (sometimes much faster if every occupant has a different size).  Each occupant is 

guaranteed to be able to fit through a space with width equal to the occupant’s diameter plus 

twice this value. 

 Constrain Edge Length: controls the triangulation algorithm used to convert the rooms, 

stairways, etc. into the triangulated mesh used by the simulator.  By default, Pathfinder 

attempts to generate the fewest and largest possible triangles and this approach works well 

with Pathfinder's search algorithms.  However, in some situations, "well behaved" triangles can 

be useful (e.g. to prevent extremely long, thin triangles).  This value can be used to "fatten" 

these triangles.  The Max Edge Length parameter controls the maximum length of any single 

edge on a room boundary, and the Min Angle criteria prevents the system from using triangles 
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with any very small (i.e. thin) angles.  Using Min Angle values greater than 30 degrees can cause 

Pathfinder to "freeze" when it attempts to generate a simulation input file. 

Behavior Parameters 

The Behavior tab allows you to set options for Pathfinder's two primary simulation modes: SFPE and 

Steering.  To select a simulation mode, choose SFPE or Steering from the Behavior Mode drop-down 

box.   

SFPE Mode Parameters 

The SFPE mode uses the set of assumptions presented in the SFPE Handbook of Fire Protection 

Engineering and can give answers extremely similar to these hand calculations, depending on selected 

assumptions.  In SFPE simulations, the mechanism that controls simulation movement is the door 

queue.  The SFPE mode uses a simple set of assumptions and usually completes much faster than a 

comparable steering mode simulation in terms of CPU time. 

 

Figure 7-4: SFPE Behavior tab of the Simulation Parameters dialog 

The SFPE mode supports the following options: 

 Max Room Density: controls the density at which doors will no longer admit occupants into a 

room.  Using an artificially low value for this number will give faster evacuation times.  Using a 

higher number 3.6 - 3.8 can cause extremely slow evacuation times.  Using values above 3.8 

pers/m2 can cause the simulation to get stuck due to the density dependent velocity calculation. 

 Boundary Layer:  This value is subtracted from both sides of a door to calculate the effective 

door width, controlling the flow rate equation.  For example, with a Door Boundary Layer 

setting of 150 mm, a 1.0 m door would be reduced to a 0.7 m opening giving an Fs_max of (1.32 

pers/s-m * 0.7 m) = 0.924 pers/s. 

 Door Flow Rates at High Density: controls how specific flow for doors is calculated.  Specific 

flow is a measure of occupants per unit of time per unit of effective width.  For each door, the 

specific flow is multiplied by the effective door width to calculate the door flowrate in occupants 

per unit of time. 
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o Use a Calculated Specific Flow: specific flow is calculated as a function of room density 

for a room adjacent to the door.  In cases of counterflow, the room with the higher 

density controls the combined specific flow of the door. 

o Always Use Max Specific Flow: specific flow is always 1.32 pers/s/m.   

Steering Mode Parameters 

The Steering mode is more dependent on collision avoidance and occupant interaction for the final 

answer and often gives answers more similar to experimental data than the SFPE mode (i.e. steering 

mode often reports faster evacuation times).  Door queues are not explicitly used in Steering mode, 

though they do form naturally. 

 

Figure 7-5: The Steering Behavior tab of the Simulation Parameters dialog 

The Steering mode supports the following options: 

 Steering update interval: specifies how often (in simulation time) to update the steering 

calculation.  This could also be considered to be the cognitive response time of each occupant.  

The higher this number, the faster the simulation will run, as long as the simulation time step is 

less, but the poorer the decision making skills of each occupant will be. 

 Collision Handling: controls whether occupants avoid one another and can collide with each 

other. 

 Limit Door Flow Rate: When checked, this imposes a maximum flowrate on doors unless they 

have it explicitly turned off (see Door properties on page 26). The flowrate for each door is 

calculated from the Boundary Layer and Specific Flow, similarly to SFPE Mode. The difference 

between Steering and SFPE Modes is that Steering does not allow flowrates to be based off 

room density. 

Starting and Managing a Simulation 
To run a simulation: on the Model menu, click Run Simulation... ( ). The simulation will begin and the 

Run Simulation dialog (shown in Figure 7-6) will appear. 
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Figure 7-6: The Run Simulation dialog showing a partially complete simulation. 

In this dialog, the abbreviation DTG stands for distance to goal.  The maximum distance to goal 

represents distance to goal for the occupant farthest from its goal.  The average distance to goal is the 

average of all occupants' distances to their respective goals. 

The Debug button launches a runtime visualization that shows the progress of the simulation as it is 

taking place.  This function is different from the Results button which launches the 3D visualization view 

for simulation results. 

A simulation can also be paused, resumed, and cancelled at any time. 

Simulating via command-line 

Simulations can also be run through the command-line without loading the user interface.  To do so, 

open a command prompt.  Run “testsim.bat” located in the Pathfinder install folder.  The only argument 

is the input .txt file generated by Pathfinder.  Pathfinder automatically creates this file when performing 

a simulation through the user interface.  The input file can be manually created in the user interface by 

going to the File menu and selecting Save Simulator Input….  When running a simulation this way, it 

may also be desirable to manually create the geometry file for visualization.  To do this, from the File 

menu choose Save Imported Geometry File…. 

NOTE: Running a simulation through the command line will not provide a management dialog through 

which the simulation can be paused and resumed. 

Stopping and Resuming a Simulation 
When running a simulation, there is the option to pause and resume, but this requires Pathfinder to be 

running the entire time.  Sometimes the need arises to be able to stop a simulation and resume later 

between Pathfinder sessions, such as if the computer needs to be restarted after installing a system 

update.   
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To stop a simulation, press Cancel during a simulation in the simulation dialog.  Pathfinder will ask the 

user if a snapshot should be made.  Before selecting Yes, make note of the simulation time.  After 

choosing Yes, a snapshot file is written into the same directory as the result with a filename similar to 

the following: 

untitled_XXXXX.XXX.snapshot 

where the X’s are replaced with the simulation time at which the simulation was stopped.  The snapshot 

file can later be resumed.  To resume it, go to the Simulation menu, and select Resume Simulation…  

Then select the snapshot file.  The simulation will resume from the time it was stopped.  Note that the 

Pathfinder file from which the simulation originated should be open to resume a simulation. 

Stuck Occupants 
Sometimes occupants become "stuck" preventing a proper simulation run.  There can be many causes of 

this problem and we do everything we can to prevent it, but it does happen.  If occupants are becoming 

stuck in tight spaces, consider altering the geometry in that space or reduce the occupants’ Reduction 

Factor in their profile.  Also consider using the SFPE simulation mode with collision handling disabled.  

This mode uses the simplest set of assumptions and is not very susceptible to the geometric and 

movement irregularities that can cause occupants to become stuck. 
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8. Results 

Summary Report 
The summary report file contains information about the simulation geometry, simulation performance, 

and usage information for each room, stairway, and door.  Figure 8-1 shows a portion of an example 

summary report file. 

 

Figure 8-1: Listing for an example summary report file. 

This file is saved in the simulation directory and given the name name_summary.txt (where name is the 

name of your saved PTH file).  To view it, under the Results menu choose Show Summary File.  The first 

section shows the mode the simulation was run in, the total number of occupants, and statistics on the 

evacuation time.  It also shows some information about the mesh, including the number of triangles and 

the doors.  This information can be useful when considering the complexity of a simulation from the 

standpoint of the simulator. 

The table gives a listing of each component (doors, rooms, and stairs) in the simulation.  For each 

component, the FIRST IN column shows the simulation time when the first occupant entered that 

component.  LAST OUT shows the simulation time when the last occupant exited that component.  The 

TOTAL USE column shows how many times a component was entered by occupants.  For doors that 

served more than 1 occupant, the FLOW AVG. column shows the result of dividing the total use by the 

amount of time the room was in use (LAST OUT - FIRST IN). 
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Door History 
The door history file (name_doors.csv, where name is the name of your saved PTH file) provides results 

data for doors.  Each row represents a different time step, and the columns are as follows: 

 time(s):  The output time for this data row.  The frequency of output is controlled by the CSV 

Output Freq. box in the Simulation Parameters dialog. 

 Remaining (total):  The number of occupants remaining in the simulation. 

 Exited (total):  The number of occupants that have successfully passed through an exit door 

(leaving the simulation). 

 doorname width(m): The total width of the specified door. 

 doorname total boundary(m): The total boundary layer of the specified door. 

 doorname  [{+,-}{X,Y}]:  The number of occupants who have passed through door doorname 

since the previous output in the specified direction.  For columns with no direction specification, 

this is the total number of occupants to pass through the door in both directions since the 

previous output. 

 doorname (Q):  The number of occupants who are waiting in the queue to pass through door 

doorname at the current time.  This only includes occupants who have actually reached the door 

and are waiting to enter.  Occupants that are stacked up waiting to reach a door will not be 

counted.  This value is only meaningful in SFPE mode. 

This file is used to display door flowrate, specific flow, and usage history in Pathfinder. 

Door Flowrate and Specific Flow 

To view door flowrate or specific flow, click View Door Flow Rates... on the Results menu.  This opens a 

time history plot for doors as in Figure 8-2.  This plot shows data from the door history file.  In the left 

portion of the window is a list of the doors, and on the right is a graph of the data. 
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Figure 8-2: A time history plot for door flow rates 

By default, door flow rates are shown.   Alternatively, on the Mode menu, choose Specific Flow to view 

door specific flow.   

There are three filtering modes for presenting the flowrate that are selectable through the View menu: 

 Raw:  this provides raw flowrate, which is simply num_occs/dt, where num_occs is the number 

of occupants to pass through the door in an output time step, and dt is the output time step. 

 Low-pass Filter:  the raw flowrate is filtered with a bi-quad low-pass filter with a user-specified 

cutoff frequency.  This is the default filter, and the default cut-off frequency is .05 Hz.  Lower 

cut-off frequencies produce smoother graphs. 

 Moving-average Filter:  the raw flowrate is averaged over a user-specified period. 

 Door Usage 

To view door usage, open the Door Flowrate Rates dialog, and on the Mode menu, select Occupant 

Counts.  This shows the number of occupants that use a particular door in each output time step.   

Alternatively, cumulative totals can be viewed by selecting Cumulative Occupant Counts.  This shows 

the total number of occupants to use the door up until that time. 

Room History 
The room history file (name_rooms.csv, where name is the name of your saved PTH file) provides the 

following information columns in each row: 

 time(s):  The output time for this data row.  The frequency of output is controlled by the CSV 

Output Freq. box in the Simulation Parameters dialog.  
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 Remaining (Total):  The number of occupants still in the simulation. 

 Exited (Total):  The number of occupants that have successfully passed through an exit door 

(leaving the simulation). 

 roomname:  The number of occupants present in room (or stairway) roomname at the current 

time. 

To display this data as a time history plot, click View Room Usage... on the results menu. 

Occupants Summary 
The occupants summary file (name_occupants.csv, where name is the name of your saved PTH file) 

provides statistics about each occupant in the simulation. Each row of the CSV represents one occupant 

and provides the following: 

 id: A unique integer identifier for the occupant assigned by the simulator. 

 name: The name given to the occupant in the user interface. 

 exit time: The time at which the occupant exited the simulation. 

 active time: The amount of time the occupant was actively seeking an exit. 

 jam time total(s): The total amount of time the occupant spent moving at less than the Jam 

Velocity as specified in the simulation parameters (see Output Parameters on page 73). 

 jam time max continuous(s): The maximum continuous amount of time the occupant spent at 

less than the Jam Velocity. 

Occupant History 
For each occupant whose profile has CSV data output enabled (see Profiles on page 49), an occupant 

history file is created with the file name, name_occupant_id_occname.csv, where name is the name of 

the saved PTH file, id is the integer id of the occupant assigned by the simulator, and occname is the 

name of the occupant specified in the user interface.  Each row in an occupant history file shows the 

following data for a particular time: 

 t(s): The output time for this data row.  The frequency of output is controlled by the CSV Output 

Freq. box in the Simulation Parameters dialog. 

 id: The integer identifier of the occupant assigned by the simulator. 

 name: The name assigned to the occupant in the user interface. 

 active: Whether the occupant is actively seeking an exit (1 if they are seeking an exit and 0 if 

not). 

 x(m), y(m), z(m): The 3D location of the occupant. 

 v(m/s): The velocity of the occupant. 

 distance(m): The total distance the occupant has travelled. 

 location: The occupant’s current room. 
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3D Results 
Pathfinder provides a real-time output visualization program for viewing 3D results.  It operates much 

like a video player in that it allows users to play, pause, stop, slide, and speed up and down time.  It is 

completely 3D and allows users to navigate through a model.   

 

Figure 8-3: 3D Results for the multi-floor-stairwell example problem 

Navigating through a model 

Once a model is loaded, the navigation tools work similarly to those found in the preprocessor.  The user 

can rotate the model ( ), zoom in and out ( ), and roam ( ).   

In the 3D results, the roam tool provides additional capabilities for navigating through the model.   

 Course Positioning:  As in the preprocessor, the roam tool allows the camera to be quickly 

moved throughout the model at the expense of precision.  To move the camera in this way in 

the XY plane, hold Ctrl while dragging the left mouse button, or drag the middle mouse button.  

To move the camera along the Z axis, hold Alt while dragging the left mouse button or drag the 

right mouse button.   

 Precise Positioning:  When the camera is roughly in the correct spot, it can be moved to a more 

precise location by using the keys, ‘w’ and ‘s’ to move the camera forward and backward along 

the viewing direction, and the keys ‘a’ and ‘d’ to move the camera left and right, respectively.  In 

addition, ‘Space’ moves the camera up along the Z-axis, and ‘c’ moves the camera down.  

Pressing these keys moves the camera at a fixed speed.  Holding ‘Shift’ while pressing them 

doubles the speed. 

 Smooth Positioning:  The roam tool can also be used to smoothly animate the camera to any 

location.  To do so, press and release the middle mouse button.  The cursor will disappear, and 
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the tool will enter Roam Mode.  In this mode, moving the mouse will pivot the camera about its 

location.  Pressing and dragging the left mouse button will move the camera in the XY plane. The 

further the mouse is moved from its button press, the faster the camera will move. This can 

simulate the effect of accelerating the camera.  Doing the same with the middle mouse button 

will cause the camera to move forward/backward  in the XY plane with changes along the Y 

mouse axis and turn left/right with changes along the X mouse axis.  Pressing and dragging the 

right mouse button will move the camera along the Z axis in the same manner.  To exit Roam 

Mode, press and release the middle mouse button again or press Esc on the keyboard. 

At any time, press Ctrl+R to reset the camera view. 

Displaying geometry input 

If a DXF, FDS, PyroSim, or background image file has been imported in a Pathfinder simulation, this 

geometry will be shown by default in the 3D results.  If not, the navigation geometry used by the 

simulator will be displayed, which only contains walking space, doors, stairs, and exits.  These two 

geometry sets can be viewed in combination or individually through the Scene menu: 

 Show Nav Mesh over Imported Geom – this shows the navigation mesh and the imported 

geometry with the navigation mesh on top.  This is useful to see how the navigation mesh lines 

up with the imported model. 

 Show Imported Geom over Nav Mesh – like the first option, this shows the navigation mesh 

and the imported geometry together but with the imported geometry on top.  This display is 

useful if the imported geometry is the most interesting geometry to display but the navigation 

mesh fills in some missing pieces from the imported geometry, such as stairs or elevators. 

 Show Nav Mesh Only – this shows only the navigation mesh. 

 Show Imported Geom Only – this shows only the imported geometry. 

Displaying occupants 

Occupants can be displayed in several ways.  They can be shown as simple shapes, as realistic people, or 

as the artist’s wood mannequin.  All display options are found under the Agents menu. 

The first way to display occupants is as simple shapes, including disks and cylinders.  Because of the 

simplicity, this is the fastest way to view agents (for loading and on some graphics cards, rendering 

speed), but it is the least realistic and contains little animation.   

Another way to display occupants is as realistic people.  The avatar selected in the pre-processor 

determines which avatar is shown in the 3D results.  Displayed this way, occupants may render slower 

on some graphics cards and will take longer to load, but the scene will appear much more realistic and 

should still be fast enough to display hundreds to thousands of occupants depending on the processor 

speed and graphics card. 

The last way to display occupants is as the artist’s mannequin.   Generally, this is faster than showing 

people and is completely generic, contains animation, and still provides a degree of realism above 

simple shapes.  It does not, however, represent colors set on the occupants. 
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Selecting Occupants 

Occupants can be selected for tracking purposes by clicking on the occupant.  When selected, the 

occupant and their path (if displayed) will turn yellow.  Multiple occupants can be selected by holding 

CTRL when clicking them.  They can be de-selected by clicking anywhere else in the model. 

Viewing multi-floor problems 

Some models are composed of several floors, causing each floor to obscure the one below it as shown in 

Figure 8-5 (a).  Pathfinder provides a variety of options for viewing the model such that the occupants 

inside can be easily observed.  One option is to view the model with the floors stacked vertically but 

separated by a set amount.  Another option is to view the model with the floors laid out in the XY plane 

so that they can all be viewed from overhead.  Both options allow a wall clip-height to be specified. 

To use any of the layout options, floors must first be defined.  If the floors were defined in the pre-

processor, they will carry through to the 3D visualization and no additional input is needed.  If they have 

not been defined or they need to be modified, this can be done by opening the Scene menu and 

selecting Edit Floors….  A dialog will appear that shows a list of the Z locations of the floors as shown in 

Figure 8-4.  From this list, floor locations can be added, removed, and modified.  Once OK is pressed, the 

3D results viewer will partition the geometry among the floors such that the bottom floor contains all 

geometry from -∞ to the next floor’s location, the top floor contains all geometry from its location to 

+∞, and every other floor contains geometry from its location to the next floor’s location. 

 

Figure 8-4: Floor location dialog for 3D results 

Once the floors are defined, wall clipping can be applied to shorten the walls yet maintain a sense of 

obstruction placement as shown in Figure 8-5 (b).  As shown in this figure, more of the model can be 

seen than in Figure 8-5 (a).  The wall height can be set in the toolbar above the 3D view.  If this value is 

set above 0, the geometry on every floor will be clipped above the floor’s Z location plus the wall height.  

If the value is set to 0, the full wall height is used. 

To stack floors vertically along the Z axis, open the Scene menu and select Layout Floors Vertically.  

When viewed in this manner, floors will appear naturally such that each floor is stacked on top of the 

one below it.  The floors can then be separated by empty space to more easily view inside the model as 

shown in Figure 8-5 (c).  This Floor Separation can be set in the toolbar above the 3D view. 
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To layout floors in the XY plane, open the Scene menu and select Layout Floors Horizontally.  The floors 

will be laid out in a square grid and in one plane.  They will appear in order from left to right and top to 

bottom such that the lowest floor is in the upper left corner and the highest floor is in the lower right 

corner.  When laid out in this manner, the Floor Separation will affect the gap between floors in both 

the X and Y directions.  An example of this type of layout is shown in Figure 8-5 (d).  By default, labels 

appear above each floor so the floors can be easily identified, but these labels can be hidden by opening 

the View menu and deselecting Show Labels. 

  
(a) (b) 

  
(c) (d) 

Figure 8-5: Multi-floor layout options in 3D results (FDS model courtesy of Andreas Niggemeyer) 

Animation playback 

To play back animation, press the play button ( ).  As the animation is playing, the time slider will 

move, and the animation can be paused ( ) or stopped ( ).  The buttons ( ) and ( ) will move the 

time slider to the beginning and end, respectively.  The buttons ( ) and ( ) will slow down and speed 

up the animation by factors of two.   

The status bar at the bottom of the screen shows information about playback.  The first section from left 

to right shows the current playback status.  This will display “Playing,” “Paused,” or “Stopped.”  The 
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following section shows the current playback time in minutes.  The next section shows the current 

playback speed.  The last section shows the current rendering speed in frames per second – a common 

speed measurement in computer graphics.  This can help determine how well a user’s computer handles 

3D playback.  Some ways to increase this are discussed in the section, Controlling drawing detail/speed. 

Refreshing Results 

Results can be viewed as a simulation is running, but they will only be current to the last load or refresh.  

To refresh the results at any time, press F5 on the keyboard or select Refresh Results in the File menu.  

The current playback time will be restored after refreshing the results, making the refresh as seamless as 

possible.  If the results are viewed before the simulation is finished, upon completion the results will 

automatically be refreshed and brought to the front of the screen. 

Viewing occupant paths 

One option that can help visualize flow in an evacuation is to turn on occupant paths.  This can be 

enabled by checking Show Occupant Paths in the View menu.  When turned on, each occupant’s path 

will be drawn from t=0 to the current playing time. 

Controlling drawing detail/speed 

There are several options controlling the drawing detail and ultimately speed in the 3D results, including 

level-of-detail rendering, hardware versus software rendering, and vertex buffers. 

One way to vastly increase speed while only somewhat sacrificing quality is to enable view-dependent 

level-of-detail rendering.  This can be enabled by checking Enable Level of Detail under the View menu.  

The idea behind this option is that objects far from the camera require less detail to portray the object 

realistically than for those close to the camera. 

Another improvement for many modern graphics cards is to animate the occupants in hardware.  To do 

this, select Animate Characters in Hardware under the View menu.  For these graphics cards, this, 

coupled with vertex buffers can vastly improve performance.  Some older graphics cards, however, will 

support it but will actually render slower when using it.  It is recommended that the user play with this 

option and observe the difference in frame rate (shown at the bottom right in the status bar).  

Recommended graphics cards include the Nvidia Geforce (GTX, especially) and AMD Radeon HD series. 

These will work best with the hardware animation option. 

The last speed option available is using vertex buffers, which is enabled by checking Enable Vertex 

Buffers under the view menu.  Hardware vertex buffers allow geometric data to be stored in video 

memory to reduce data that must be sent over the graphics bus from main memory, which can increase 

rendering speed.  We have found, however, that integrated Intel video cards often have trouble with 

this option, so it may need to be disabled for these cards. 

The two options, Animate Characters in Hardware and Enable Vertex Buffers, when combined tend to 

provide the most benefit on newer graphics hardware. 
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Creating Movies 

Movies can be created from the 3D results for playback on a PC using a video player such as Windows 

Media Player.  Creating a movie file allows the results to be distributed to others who do not have the 

3D results software that is bundled with Pathfinder.  Movies can be created in two different ways.  One 

way is to create a high-quality movie that is rendered offline from a fixed camera angle.  The other is to 

create a lower-quality movie in real-time that allows the camera angle and scene to change dynamically. 

High Quality Movies 

High quality movies are useful if a user wants a movie that is unrestricted by size and frame rate.  This 

means that it will play back smoothly at any resolution and with any high-quality settings turned on, 

regardless of the complexity of the scene.  The major disadvantage to this type of movie is that the 

camera angle remains fixed throughout the length of the movie, and the user cannot interact with the 

scene (such as changing the selected occupant, turning on and off paths, etc.) while the movie is being 

created.   

To create a high-quality movie, open the File menu and select Create Movie….  A file chooser will ask for 

the file name of the resulting movie.  From this file chooser, the type of movie can be specified as an 

Audio-Video Interlaced (AVI) file or a Windows Media Format (WMV) file.  AVI files can be rendered as 

uncompressed or compressed.  WMV files can only be compressed.  Uncompressed files will be very 

large but will be of the highest-quality.  Compressed files are much smaller in size but with some 

reduced quality.  To create compressed AVI files, video codecs must be installed on both the computer 

that will create the file and the computer that will play back the file.  Some popular AVI codecs include 

Xvid, Divx, and ffdshow.  WMV files, however, do not require special codecs to be installed on either the 

source or destination computers, but they will only work on Windows machines unless special software 

is installed on another platform. 

Once the filename and type of video has been chosen, a dialog will show some movie making options as 

in Figure 8-6 (a).  The options are as follows: 

 Video Size specifies the resulting video’s dimensions.  This is only limited by the maximum size 

of a viewport on the computer’s video hardware; with some codecs, however, each dimension 

must be a multiple of 2 or 4.  If you have trouble creating a movie, try making the size a multiple 

of 4.  The Use window size button will set the size to the 3D window’s current size.   

 Framerate determines how smoothly the video will play back.  The higher this number is, the 

smoother the playback at the expense of longer rendering time to create the movie and larger 

file size.  30 frames/second provides reasonably smooth video playback.   

 Speed specifies the speed at which the results will play.  1 X will play the movie at real-time 

speed, 2 X will play the movie twice real-time, etc.   

 Enable Level of Detail specifies that level of detail rendering should be turned on while creating 

the movie.  This will lower the resulting quality, but it will decrease the time to make the movie 

on scenes with many occupants. 

 Watch Movie when Finished specifies that the resulting movie should open in the default video 

player for the chosen video type when the movie is completed. 
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 Compressor shows which video codec is currently selected and allows the codec to be chosen 

and configured.  If Configure… is pressed, another dialog will show as in Figure 8-6 (b).  This 

dialog will show a list of the codecs currently installed on the computer.  Some codecs allow 

certain properties, such as the Quality, Data Rate, and Keyframe interval to be specified.  These 

properties control the resulting movie’s quality, file size, and seeking performance (how well a 

movie can be skipped around in the video player), respectively.  Some codecs do not expose 

these properties through this dialog, however.  To configure these codecs, you must press the 

additional Configure… button if it is enabled. 

  
(a) (b) 

Figure 8-6: Movie option dialogs 

Once the properties have been specified, press OK to start making the movie.  While the movie is being 

created, a progress dialog will show how close the movie is to being finished.  If the movie is cancelled 

before it is completed, there will still be a valid video; it just will not play the entire results. 

Real-time Movies 

Movies can also be created in real-time.  This means that it will record while the user is interacting with 

the results and it will record everything the user sees except for the cursor.  The disadvantage of this 

type of movie is that it will play back only as smooth and of the same quality as that which the user who 

created the movie saw.  So if the scene is very complex and the movie creator’s computer cannot view 

the results smoothly, the resulting movie’s play back will suffer as well. 

To create a movie of this type, press the record button ( ).  A file chooser dialog will prompt for the file 

name of the movie.  For real-time movies the only allowable type is WMV.  Once the file name is chosen, 

the codec configuration dialog will be shown as in Figure 8-6 (b).  When OK is pressed on this dialog, the 

movie will begin recording.  At this point, anything the user sees will be recorded in the movie.  Now the 

user can change the camera angle, start and stop playback, select occupants, change view settings, etc. 

and the movie will capture everything.  At any time, the movie can be paused or stopped.  Pausing the 

movie will stop the recording but leave the movie file open so that recording can be resumed to the 

same file.  This allows the user to perform some action that they do not want to be recorded.  To pause 

movie recording, press the pause movie button ( ).  To resume recording, press the resume movie 
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button ( ).  Stopping the movie will end recording and disallow any further recording to the file.  To 

stop recording, press the stop movie button ( ). 
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